# Table of Contents

**Scanning and Configuring** ............................................ 1
  Default Settings .......................................................... 1
  Scan from the Button Panel ............................................ 2
    Features of the Button Panel ...................................... 3
  Changing the Button Settings ....................................... 4
  Selecting Options for OneTouch ..................................... 6
  Custom File Naming ..................................................... 7
    Build file name using tokens ..................................... 8
    Prompt for file name ............................................... 11
  Scan Configurations .................................................. 12
    Scan Settings Tab ................................................... 13
    Page Settings Tab .................................................. 15
    Acuity Settings Tab ................................................ 18
    VRS Settings Tab .................................................... 20
    Advanced Settings Tab ............................................. 22
    Redaction Settings Tab ............................................ 22
  File Formats ............................................................ 26
    Create Single Image Files ........................................ 26
    Image Formats ........................................................ 26
    Text Formats .......................................................... 28
  Configure Before Scan ................................................ 30
    Scan Using Configure Before Scan ................................ 31
  Scanning with Job Separation ....................................... 32
  Selecting OCR Options for Text Formats ............................ 35
    The OCR Tab ........................................................... 36
    Creating Your Own Dictionaries ................................... 37
    Editing User Dictionaries .......................................... 39
    The Format Tab ........................................................ 40
**Scan Destinations** ..................................................... 43
  Open Scanned Document(s) ............................................ 43
  Transfer to Storage ..................................................... 44
    Setting the Folder and Options from OneTouch .................. 44
    Setting the Folder from Windows ................................ 46
  Scanning to Multiple Folders ....................................... 46
  Burn to CD-ROM .......................................................... 50
# Table of Contents

- Printer or Fax .................................................. 51
- PaperPort ....................................................... 53
- SharePoint ....................................................... 55
  - SharePoint Link Log Viewer .................................. 57
- FTP Transfer ..................................................... 58
  - FTP Link Log Viewer .......................................... 60
- SMTP ............................................................. 61
  - SMTP Link Log Viewer ......................................... 63
- Email Applications .............................................. 63
  - Email Properties ............................................... 64
- Text Editors .................................................... 65
  - Text Documents Properties ................................... 66
  - Adding Text Editor Applications ............................... 67
  - Creating an HTML Page ....................................... 68
- Still Image Client ............................................... 69
- Image Editors ................................................... 70
  - Image Documents Properties .................................. 71
  - Adding Image Editor Applications ............................. 72
- PDF Applications ............................................... 73
- Send to Application ............................................. 75
- Scanning to Multiple Destinations .............................. 79

## Hardware Properties ........................................ 83

- Device Settings ................................................ 84
- Driver Settings .................................................. 85
- Application Settings ............................................ 85

## Troubleshooting ................................................. 87

## Appendix A: Copy Regulations ................................ 89

- United States .................................................... 89
- Canada ............................................................. 90
- Other Countries .................................................. 91

## Index ............................................................. 93
Before scanning, please take a moment to read through the scanner’s user guide for important instructions about how to use the scanner.

The scanner user guide includes information on what type of documents can and cannot be scanned with your scanner. It also contains full setup and installation instructions, maintenance and troubleshooting procedures, scanner specifications, and scanner warranty information. The guide is located in the user guides section on the installation disc.

The information in this guide will cover hardware and software features that may not be available for the scanner model you purchased. Please disregard any information that does not apply to your scanner.

Some of the illustrations in this guide may not look exactly as they appear on your computer’s screen. The differences are minor and do not affect the steps to use the features.

**DEFAULT SETTINGS**

The Visioneer OneTouch icon will be displayed in the Windows notification area when the scanner is connected to the computer and ready to scan.

![OneTouch Icon](image)

When you installed OneTouch, the software was automatically configured with appropriate settings consisting of: a **Destination Application**, a **Scan Configuration**, and a **File Format**. The icons on the OneTouch button panel indicate the destination application where the scans will be sent.

If the current scanner’s control panel has multiple scan options, the OneTouch button panel will show one button for each of the functions.
If the scanner has one scanning function, the OneTouch button panel will display one button and the detailed scan settings.

A folder icon for a button means that the button is set up to archive the scanned item. The scanner sends the scanned image directly to a folder without opening the image first in a software application.

A question mark for a button means your computer does not have the appropriate software or hardware for the initial factory settings.

**Note:** The default page size in each configuration is based on your computer's Windows Measurement system selection of U.S. (United States) or Metric units.

- If U.S. is the selected measurement, the default page size in each profile will be based on the United States standard paper sizes such as 8.5 x 11 inches.
- If Metric is the selected measurement, the default page size in each profile is based on the ISO 216 standard and the majority of the profiles will default to A4.

### Scan from the Button Panel

Scanning from the button panel works like pressing a button on your scanner, or using the scanner’s PaperIn function (depending on the scanner model). The scanner scans the item, then sends the image to the Destination Application indicated by the button’s icon.

Please refer to the “Loading Documents” chapter of the scanner's user guide for instructions on using the scanner buttons. If your scanner does have an automatic scanning option, the instructions in the scanner guide will contain instructions for turning off AutoLaunch so that you can scan using the OneTouch button panel.

**To scan from the Button panel:**

1. Load the documents into the scanner.
2. Click on the OneTouch icon in the Windows notification area.
3. The OneTouch Button Panel opens.

4. Click the button you want to use to scan.

5. The scanner starts scanning and the image is sent to the selected destination for the OneTouch button you are using to scan.

**Technical Note:** Automatic Document Feeder and Sheetfed scanners:

When scanning using OneTouch, wait until the OneTouch status bar indicates that the scan process is complete before placing a new document in the scanner. If OneTouch is still processing the current scan job when a new document is placed in the scanner, the new document may automatically be scanned and appended to the current scan job being processed.

**Features of the Button Panel**

The OneTouch panel is your on-screen set of controls for the scanner. From the panel you can access the hardware settings for your scanner and configure the scanning buttons.

Click on the OneTouch icon to open the panel.

**The Title Bar**

- Green arrows—click to cycle through the panel’s views.
- Scanner icon—click to open the scanner’s hardware properties.
- Red “X”—click to close the OneTouch panel.

**The Button View—Scanners with Multiple Buttons**

If the connected scanner has a control panel with multiple scan options, the OneTouch button panel will show one button for each of the functions.

- **Left-click** on a Destination Application icon to start scanning.
- **Right-click** on a Destination Application icon to open the OneTouch Properties.
- **Left-click** on the arrow buttons, on the right side of the panel, to view the rest of the OneTouch buttons.
The Detail View—All Scanners

If the connected scanner has one scanning function, the OneTouch button panel will display one button and the detailed scan settings.

- **Left-click** on a Destination Application icon to start scanning.
- **Right-click** on a Destination Application icon to open the OneTouch Properties.
- **Single-click** on the detailed information to open the OneTouch Properties.

The Hardware View

- **Left-click** on the scanner icon to return to the Button view.
- **Right-click** on the scanner icon to open the scanner’s hardware properties.

### Changing the Button Settings

A OneTouch button configuration consists of a **Destination Application**, a **Scan Configuration**, and a **File Format**. The OneTouch Properties window is where you select these three elements for a button.

1. Click on the OneTouch icon.
2. Right-click a button on the OneTouch Button Panel.

- Scanners with Simplex and Duplex buttons—the OneTouch Properties window will open when you press, hold down for 3 seconds, and release the Simplex or Duplex button.

- Scanners with multiple scanning buttons—the OneTouch Properties window will open when you press, hold down for 3 seconds, and release a scanner button. (For example, a **Scan** or **Copy** button)
3. The OneTouch Properties window opens.

   ![The OneTouch Properties window](image)

   Some of the options on the OneTouch Properties Window are “grayed out” and are not available, these options are not appropriate for your scanner model.

4. If your scanner has multiple scanner buttons, or an LED function selector on the scanner, select the button in OneTouch that you want to change. If your scanner has only one button option, proceed to the next step to continue changing the scan settings.

   - **LED Number**—Click the up or down arrow to cycle through the OneTouch buttons.
   - **Button Tabs**—Click on one of the tabs, across the top of the OneTouch properties window, to configure that scanner button. There is one tab for each button on the scanner as well as the Options tab to change button specific features.

5. Select the destination you want OneTouch to send the scanned image to in the **Select destination** list.

   If you select a word processing program such as Microsoft WordPad or Microsoft Word that can be used for OCR (such as TXT or RTF), the text in scanned images is automatically converted to word processing text.

6. Select a file format in the **Select format** panel.

   The formats are based on the type of Destination Application you select. The icon names indicate their file types. See **File Formats** on page 26 for more information about the available formats.

7. Select a scanning configuration in the **Select configuration** list.

   The configuration's basic settings include: scanning mode, resolution (dpi), page size, brightness (Br), and contrast (Cr). Refer to **Scan Configurations** on page 12 and **Configure Before Scan** on page 30 for instructions on creating and modifying scan configurations.

8. Click on **OK** to save the changes.

9. Place an item in the scanner and click the OneTouch button to start scanning.

   The scanner scans and sends the image to the selected destination, with the file format and scan configuration you specified.

   **Properties** button—displays a window for selecting properties for a destination. This button is disabled if the selected destination application does not have global configuration properties.
**Refresh** button—updates the links between all your computer’s Destination Applications and OneTouch. If you install new software that can be used as a Destination Application, click the **Refresh** button to link the new software to OneTouch.

**New/Copy/Edit/Delete** buttons—click **New** or **Copy** to add new scan configurations to the list. Click **Edit** or **Delete** to change or remove them.

**OK/Cancel/Apply** buttons—**OK** accepts any changes and closes the window. **Apply** accepts any changes but leaves the window open so you can continue making additional changes. **Cancel** closes the window without accepting any changes.

## Selecting Options for OneTouch

Use the **Options** tab to configure how OneTouch works with the selected button, such as which destinations are available, or what the file name should be.

### Select Button

Click the down arrow and select the button for which you want to modify the settings from the list. The options you choose in this window only apply to the button you select in this list.

### Show all destinations

This option selects all of the Destination Application categories. The list of Destination Applications available for the selected button will include all the applications on your computer that fall into these categories.

### Select destinations

Select this option to individually choose the types of applications to include in the list of Destination Applications. Check the boxes for the type of application to include.

### Destination Categories:

- **Document management** includes Nuance PaperPort and other applications for processing and keeping track of your scanned documents. This category includes the Send to Application and Open Scanned Document(s) destinations.

- **Image editors** include Microsoft Paint and other drawing and graphics applications.
- **Text editors** include Microsoft Word and WordPad, Microsoft Excel, and other word processing and spreadsheet applications. Select this option if you want OCR processing to convert your scanned documents to text that you can edit.

- **PDF applications** are for viewing and/or editing Adobe PDF files.

- **Email** includes Microsoft Outlook and other email applications, as well as the SMTP destination which allows you to scan directly to the SMTP server without opening an email client application.

- **Storage and CD-R/W** is for scanning directly to a folder on the computer, server, FTP server, SharePoint site, or to the Windows CD temp directory for burning the files to a CD.

- **Fax and Print** is for sending your scanned documents directly to your printer or fax software.

- **STI event forwarding** is for using another application’s interface for scanning. The OneTouch Event Forwarding dialog box opens so you can select which application to use to continue scanning.

**Enable scanning to multiple destinations**—select this option to allow for multiple destinations to be selected, in the destination list, on the OneTouch configuration tab. Please refer to Scanning to Multiple Destinations on page 79.

**Instant delivery**—enables image transfer to the destination while scanning is in progress, provided that Create Single Image Files is also selected. If Create single image files is not selected, image transfer occurs after all pages have been scanned.

**Show progress window**—select this option to display the progress window of the document(s) during scanning.

**Use job separator when scanning multiple pages**—select this option to have the scanner separate multiple page scan jobs into separate files when scanning is complete.

Please refer to Scanning with Job Separation on page 32 for detailed information about scanning with job separation, and how it works with other options in OneTouch.

**Use custom file naming** – select this option to enable the **Configure** button so that you can customize the file name for your scanned document(s).

**Note:** Some destination applications may discard the file name settings you configure in OneTouch. This will occur if the application is set to automatically name the incoming files.

### CUSTOM FILE NAMING

Use the custom file naming option to either specify a default name template, or enable the option to prompt for the file name each time you scan. If your scanner has multiple buttons on the OneTouch button panel, the file naming options are configured separately for each button.

For scanners with multiple buttons, select the button you want to configure.

1. Select **Use custom file naming** in the OneTouch Options tab.
2. Click on the **Configure** button.
3. The properties window will open for you to configure the file name options.
   - **File name format**—Select the format type to use when naming files.
Build file name using tokens

- **File name template**—Input text and add tokens to create the file name. Previously defined templates will appear in the list and can be deleted by clicking the "x".

- **Tokens**—Automatic data to be inserted into the file name. Options include counting number, user name, date and time, etc...

  Hover the mouse cursor over each token in the list to see examples of the type of data the token will insert into the file name.

- **Special tokens**—these tokens will insert custom data into the file name.

  - \{p\}—use this token to be prompted for that part of the file name when the files are created. For example, if the file name template contains \("\{p\} \{#b\}\)\", a prompt will appear on-screen to input the text that will replace \(p\) in the file name.

  - \{clipboard\}—use this token to insert text that has been copied to the Windows clipboard into the file name. Note that the file may not be created or an error may appear on-screen if the clipboard contains invalid characters, or too many characters.

  - \{env=\}—use this token to define an environment variable to be inserted into the file name. Input the environment variable, without spaces, between the “=” and “}” in the token after adding it to the file name template. For example, if you want the user’s domain inserted into the file name, the token should be set \{env=USERDOMAIN\}. If an invalid variable or character is defined, the final file name will contain either “NotFound” or “NotValid”.

  - \{Barcode\}—use this token when barcode detection is enabled through the TWAIN interface. When a supported barcode is detected, the file name will include the metadata contained in the barcode. To enable barcode detection, see Use TWAIN Driver PLUS Settings on page 14 or Configure Before Scan on page 30 for information on configuring the TWAIN interface.

The other available tokens are listed below. Not all tokens work with all scanners.

<table>
<thead>
<tr>
<th>Token</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(#b)</td>
<td>Incrementing number; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>(#_b)</td>
<td>Counter padded with spaces; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>(#0b)</td>
<td>Counter padded with zeroes; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>(#s)</td>
<td>Incrementing number - Sheets of paper; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>(#_s)</td>
<td>Incrementing number padded with spaces - Sheets of paper; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>(#0s)</td>
<td>Incrementing number padded with zeroes - Sheets of paper; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>(#b1i)</td>
<td>Incrementing number for counter 1 (images); enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>(#_b1i)</td>
<td>Incrementing number for counter 1 (images) padded with spaces; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>(#0b1i)</td>
<td>Incrementing number for counter 1 (images) padded with zeroes; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>(#b1s)</td>
<td>Incrementing number for counter 1(sheets of paper); enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>Token</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>{#_b1s}</td>
<td>Incrementing number for counter 1 (sheets of paper) padded with spaces; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>#[0b1s]</td>
<td>Incrementing number for counter 1 (sheets of paper) padded with zeroes; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>{#b2}</td>
<td>Incrementing number for counter 2; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>{#_b2}</td>
<td>Incrementing number for counter 2 padded with spaces; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>#[0b2]</td>
<td>Incrementing number for counter 2 padded with zeroes; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>{#b3}</td>
<td>Incrementing number for counter 3; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>{#_b3}</td>
<td>Incrementing number for counter 3 padded with spaces; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>#[0b3]</td>
<td>Incrementing number for counter 3 padded with zeroes; enables &quot;Counter options&quot;</td>
</tr>
<tr>
<td>(prn)</td>
<td>Text printed on the page</td>
</tr>
<tr>
<td>(FN)</td>
<td>Scanner friendly name</td>
</tr>
<tr>
<td>(BatchID)</td>
<td>A unique batch identification number</td>
</tr>
<tr>
<td>(User)</td>
<td>User name</td>
</tr>
<tr>
<td>(Mach)</td>
<td>Computer name</td>
</tr>
<tr>
<td>(Dest)</td>
<td>Destination application name</td>
</tr>
<tr>
<td>(Btn)</td>
<td>OneTouch button name</td>
</tr>
<tr>
<td>(Side)</td>
<td>Image side from the original document (front or back)</td>
</tr>
<tr>
<td>(Mode)</td>
<td>Scan color mode</td>
</tr>
<tr>
<td>(Size)</td>
<td>Document size</td>
</tr>
<tr>
<td>(MMMM)</td>
<td>Full name of the month (August)</td>
</tr>
<tr>
<td>( MMMM)</td>
<td>Abbreviated 3-letter month (Aug)</td>
</tr>
<tr>
<td>(MM)</td>
<td>Numeric month with a zero added to single-digit months (08)</td>
</tr>
<tr>
<td>(M)</td>
<td>Numeric month without a zero added to single-digit months (8)</td>
</tr>
<tr>
<td>(DDDD)</td>
<td>Full name of the day (Monday)</td>
</tr>
<tr>
<td>(DDD)</td>
<td>Abbreviated 3-letter day (Mon)</td>
</tr>
<tr>
<td>(DD)</td>
<td>Numeric month with a zero added to single-digit day (04)</td>
</tr>
<tr>
<td>(D)</td>
<td>Numeric month without a zero added to single-digit day (4)</td>
</tr>
<tr>
<td>(YYYY)</td>
<td>Four-digit year (1997)</td>
</tr>
<tr>
<td>(YY)</td>
<td>Two-digit year (97)</td>
</tr>
<tr>
<td>(HH)</td>
<td>24-hour clock hour with a zero added to single-digit time values (02)</td>
</tr>
<tr>
<td>(H)</td>
<td>24-hour clock hour with a zero added to single-digit time values (2)</td>
</tr>
<tr>
<td>(hh)</td>
<td>12-hour clock hour with a zero added to single-digit time values (02)</td>
</tr>
<tr>
<td>(h)</td>
<td>12-hour clock hour with a zero added to single-digit time values (2)</td>
</tr>
<tr>
<td>(mm)</td>
<td>Minute with a zero added to single-digit time values (07)</td>
</tr>
<tr>
<td>(m)</td>
<td>Minute without a zero added to single-digit time value (7)</td>
</tr>
<tr>
<td>(ss)</td>
<td>Seconds with a zero added to single-digit time values (09)</td>
</tr>
<tr>
<td>(s)</td>
<td>Seconds without a zero added to single-digit time value (9)</td>
</tr>
<tr>
<td>(III)</td>
<td>Millisecond with a zero added to single and double-digit time values (005)</td>
</tr>
<tr>
<td>(II)</td>
<td>Millisecond with rounded to two digits (05)</td>
</tr>
</tbody>
</table>
Arrow button—Add the selected token to the file name template at the cursor location.

Counter options—Select the format options for the incrementing numbers. These options are used when one of the counter tokens ({#b} or {#0b}) is added to the file name template.

Some scanners may have additional counter options in the token list; these will also start with the # symbol.

Number of digits—This is the minimum number of digits for the counter in the file name.

Persistent counter—Select this option to have the counter increment consecutively for each file regardless of changes made to the file name template, file format, scan destination, or files deleted from the target directory.

For example, when scanning five pages as the JPG file format, the following occurs:

- **Persistent counter** is selected – five files are created with consecutive numbers 1, 2, 3, 4, and 5. When files 2 and 4 are deleted, the next five pages scanned will continue numbering from 5 and the directory will have 8 files numbered: 1, 3, 5, 6, 7, 8, 9, 10
- **Persistent counter** is not selected – five files are created with consecutive numbers 1, 2, 3, 4, and 5. When files 2 and 4 are deleted, the next five pages scanned will fill in the empty spaces in the counting numbers and the directory will have 8 files with consecutive numbering: 1, 2, 3, 4, 5, 6, 7, 8

Settings—Opens a window where you can set the starting number for the counter, manually reset the counter and configure when an automatic reset should occur.

- Start count from—Input the starting number you want for the counter.
- Reset counter button—Click to set the starting number and reset the current counter. This will set the “Current count” to the value in the “Start count from” field.
- Current count—The persistent counter’s current value.
- Last reset—The date of the last counter reset.
- Automatically reset counter—Select this option to have the persistent counter reset automatically.
  - When selecting one of the date options for the automatic reset, the reset will occur at 00:00 on the morning of that day.
    - Every day—resets at 00:00 every day.
    - Every week—resets at 00:00 on the day selected.
    - Every month—resets at 00:00 on the first day of each month.
    - Every year—resets at 00:00 on January 1st.

Ignore file extension—Select this option to have the counter increment consecutively for each file regardless of changes to the file type.

This only applies to changing the file type, if changes are made to the file name template field, the counter will reset. Selecting Persistent counter will disable this option as the count increments for every scan regardless of changes to file naming and file type.

Date format—Select how the date format should appear in the file name. This option is available when the {Date} token is in the file name template.
■ **Time format**—Select how the time format should appear in the file name. This option is available when the {Time} token is in the file name template.

■ **Prompt before overwriting existing file**—Select this option to be prompted before overwriting an existing file in the scan destination.

If you select “No” when the prompt appears, a dialogue will open for you to input a different file name.

■ **Sample output**—Displays a sample of how the file name will appear based on the text and tokens in the file name template field.

### Prompt for file name

■ **Remember last used name**—Select this option to have the scan-time prompt pre-filled with the text from the previous scan.

■ **If scan creates multiple files**—Select the action you want to occur when separate files are created from one scan job. OneTouch creates separate files when either a single-page file format is selected (i.e. BMP or JPG), when “Create single image files” is selected, or when automatic job separation is enabled.

■ **Prompt to name each file**—Select this option to have a dialogue open for you to input a name for each file as it is created.

■ **Add an incrementing number**—Select this option to be prompted one time for a file name and then have a counting number appended to each file as it is created.

■ **Format**—Select the number of digits for the incrementing number.

■ **Enclose in parentheses**—Select this option to have the incrementing number in parentheses in the file name.

■ **Field separator**—Select the type of separator you want between the file name and the incrementing number.

■ **Custom field separator**—Input the type of separator you want between the file name and the incrementing number. This option is enabled when “Custom” is the selected field separator.
SCAN CONFIGURATIONS

The scan configurations are where you select the scanning resolution, brightness, mode (color, black & white, or grayscale), and a number of other settings. To see a selected scan configuration’s settings, click its icon. Click the icon again to close the detailed information.

Create a new configuration:
- Click the New button to create a new configuration starting with the OneTouch default configuration settings.
- Select a configuration in the list, then click on the Copy button to create a new configuration starting with the settings of the currently selected configuration.

Edit or delete a configuration:
- Select the scan configuration you want to edit or delete.
  - To delete the configuration, click the Delete button.
  - To edit the configuration, click the Edit button.
    Edit the settings and click OK.

Reorder the scan configurations list:
- Left-click and hold the mouse button on the configuration you want to move. Drag the mouse cursor up or down to move that configuration’s position in the list.
- Right-click on one of the configurations and select from the menu options to move the configuration up or down by 1 position, or to the top or bottom of the list.
- Right-click on any of the configurations, hover the mouse cursor over the Sort menu option, and then select one of the automatic sorting options in the list.

Changes are saved when you click on OK in the OneTouch Properties window.

Note: Use Configure Before Scan if you want to set the options manually before scanning. See Configure Before Scan on page 30.
Default configurations:
The default scan configurations have been specifically created for your scanner. These configurations utilize the image processing features of Visioneer Acuity, such as automatic cropping and rotation. Visioneer Acuity is installed automatically when the scanner driver is installed from the installation disc. If you downloaded the scanner driver from the website, make sure you also download and install Visioneer Acuity.

Note: Visioneer Acuity is not compatible with all scanner models. If Visioneer Acuity is not on the driver download web page for your scanner, it is not compatible with your scanner model.

In the Scan Configuration Properties window, the Scan Settings, Page Settings, Advanced Settings, and Redaction Settings tabs are always available. When the Visioneer Acuity module is installed, the Acuity Settings tab will also be available for all destinations.

Based on the selected destination, additional settings tabs may also be available. If you see one of these additional settings tabs please refer to the appropriate section, as listed below, for instructions on configuring these destination specific options.

- Use the Storage Options tab to choose the storage folder for scans sent to the Transfer to Storage destination, as described on page 44.
- Use the Device Settings tab to configure Fax and Print destinations, as described on page 51.
- Use the PaperPort tab to choose the destination folder, in the Nuance PaperPort application, as described on page 53.
- Use the SharePoint tab to specify a SharePoint site, user credentials, and destination folder, as described on page 55.
- Use the FTP Transfer tab to specify an FTP site, user credentials, and destination folder, as described on page 58.
- Use the SMTP Configuration tab to specify an SMTP server, user credentials, and destination email address, as described on page 61.

Scan Settings Tab

On the Scan Configuration Properties dialog box, type a name.

Type a new name for the configuration.

Select the scan mode and drag the slider to set the resolution.

Drag the sliders to set the Brightness and Contrast.

Mode—select a scanning mode:
- **Black&White** to scan in black and white. For example, letters and memos are usually scanned in black and white.
- **Grayscale** to scan items such as documents containing drawings or black and white photographs.
- **Color** to scan color photographs and other color items. Color scans have the largest file size.

**Note:** these will be disabled when the option **Use TWAIN DriverPLUS settings** is selected, or when **Auto detect color** is selected on the Acuity Settings tab.

**Resolution**—drag the slider to the right or left to adjust the dots per inch (dpi) of the resolution. The higher the dpi setting, the sharper and clearer the scanned image. However, higher dpi settings take longer to scan and produce larger files for the scanned images.

**Brightness**—sometimes an image is scanned with the brightness and contrast set too light or too dark. For example, a note written with a light pencil may need to be scanned darker to improve legibility. Increasing or decreasing the brightness makes the scanned image lighter or darker.

**Contrast**—the difference between the lighter and darker portions of the image. Increasing the contrast emphasizes the difference between the lighter and darker portions, decreasing the contrast de-emphasizes that difference.

**Key and Lock** icon—if you want to lock the configuration, click the key icon to change it from a Key to a Lock.

### Use TWAIN Driver PLUS Settings

This option uses the TWAIN driver interface to configure the scan settings for OneTouch. Settings which are controlled by TWAIN will be disabled in the OneTouch “Scan Configuration Properties” window. This includes the **Scan Settings, Page Settings, Advanced Settings**, and **Acuity Settings** tabs. Other scan configuration tabs, such as **Redaction Settings** and **Storage Options**, will still be available, and can be configured as described in this document.

This option is available in the interface only if the connected scanner supports this feature.

1. Select **Use TWAIN Driver PLUS settings**.

![TWAIN Interface](image)

2. Click the settings icon to open the TWAIN interface.
3. Adjust the options in TWAIN as needed.

The scanning options are in the **Document Settings** and **Image Enhancement** sections of the TWAIN interface.

4. Click the **Done** button to save the changes and close the TWAIN interface.

5. Click **OK** save and close the OneTouch scan configuration.

Please see the TWAIN Scanning Guide on the installation disc for instructions. You can also click the **Help** button in the TWAIN interface to open the instructions in an Internet browser.

### Page Settings Tab

The options on the Page Settings tab will be available based on either the selected color mode (Black & White, Grayscale, or Color), or based on whether or not the scanner hardware supports the feature.

**Standard**—click the menu arrow and choose a page size from the list.

**Custom**—enter the horizontal and vertical page dimensions in the boxes. Click the name of the units, inches or millimeters, to toggle between them.

**Improvements and Settings**—it is indicated in the feature description if there is a software or hardware dependency for the option to be available.

- **Duplex**—scan both sides of the page. This option is only available if the scanner supports this feature.

The Simplex and Duplex buttons on the scanner take precedence over the OneTouch settings. In other words, if the LED number on the scanner is configured to scan as Duplex, but you press the Simplex button, the scanner scans in Simplex, and vice versa.
- **AutoCrop to original**—select this option to let the scanner automatically determine the size of the item being scanned. This option is only available if the scanner supports this feature.

- **Reduce moiré patterns**—moiré patterns are wavy, rippled lines that sometimes appear on the scanned images of photographs or illustrations, particularly newspaper and magazine illustrations. Selecting **Reduce moiré patterns** will limit or eliminate moiré patterns in the scanned image. This option is only available when scanning in Color or Grayscale at lower resolutions, and when the scanner supports this feature.

- **Straighten image**—select this option to let the scanner automatically determine if a page is skewed, then straighten its image. This option is only available if the scanner supports this feature.

  If you are scanning using an Automatic Document Feeder, and the page is fed through at too great of an angle, the image may not straighten correctly. In that case, re-scan the page using the paper guides to feed the paper in straight.

- **Edge cleanup**—select this option to have the software remove any thin lines that may be around the edges in the scanned image. These lines may appear in the edges when the item being scanned is not the exact size of the dimensions indicated in Size fields. This option is only available if the scanner supports this feature.

- **Autorotate 90**—select this option to rotate the scanned image 90 degrees clockwise when scanning is finished. Typically, you might use this option if the pages you are scanning pages that are printed in landscape, such as financial spreadsheet data. This option is only available if the scanner supports this feature.

- **Invert image**—reverses the color of each pixel in the scanned image.
  
  - When scanning in black and white, each pixel is reversed from black to white and white to black.
  
  - When scanning in grayscale each pixel is reversed to the opposite level of gray.
  
  - When scanning in color each pixel is reversed to the opposite color in the color wheel.
- **Skip blank originals**—select this option to have the scanner detect if a blank page has been fed through the scanner, and remove it from the final file. This option is only available if the scanner supports this feature.

**Sensitivity**—adjust the sensitivity level of the blank image detection.

Note that when the Options tab feature **Use job separator in multi-page batch** is enabled, and the option selected is **When a blank page is detected**, the sensitivity level for Skip Blank Originals is the sensitivity level that will be used when both features are enabled.

Note that when the feature **Use job separator in multi-page batch** is enabled, and the option selected is **When the number of images reaches**, the blank originals are discarded before the images are counted. For example, if you scan 3 pages in duplex mode, each side of the page is counted as an image and the total number of images is 6. When Skip Blank Originals is enabled, and 2 of the 3 pages in the stack are blank on one side, the total number of images counted is 4 not 6.

- **Color dropout**—color dropout is the ability of your scanner to automatically remove a color from a scanned image. For example, if you are scanning a letter with a red watermark, you can choose to filter out the red so the scanned letter just shows the text and not the red watermark. Color dropout applies to Black & White or Grayscale scanning modes. This option is only available if the scanner supports this feature.

The original with a red watermark over black text. The scanned item with the red filtered out.

- **Double feed detection**—selecting this option turns on the scanner hardware feature that detects when multiple pages feed through the scanner at one time. This option is only available if the scanner supports this feature.

- **Manual feed mode**—select this option to enable a delay from when the last page is scanned and when the scanner stops the scan job. This option is only available if the scanner supports this feature.

To scan with manual feed mode:

a. Select **Manual feed mode**.

b. In the **Timeout** field, input the amount of time you want the scanner to wait from when the last page is scanned and when the scanner stops scanning.

c. Place a document in the scanner.

d. **Click Scan**.

e. The scanning progress dialogue on-screen will display a countdown indicating how much time you have to place the next document in the scanner.

f. When you are done scanning all pages in your document, you can click on **Done** to stop the timer or simply let the timer run out.

**Note:** some scanners have a paper thickness switch or a manual feed switch that will adjust the rollers to allow for scanning items that are thicker than the maximum supported paper weight. If you adjust the scanner to allow for scanning very thick items, you will only be able to scan one item at a time. The manual feed option allows you to scan one page at a time, and have all pages scanned be in a single scan job when scanning is finished.
Acuity Settings Tab

The OneTouch software you received with your scanner includes the Visioneer® Acuity technology. This application has a set of features for improving and enhancing the quality of scanned documents, especially documents that would usually produce poorer quality images. Scan configurations with Acuity options work with OneTouch scan settings to produce the best quality images.

If Visioneer Acuity is available for your scanner, it will be installed automatically when installing the scanner driver from the installation disc. If you download the driver from our website, the download page will indicate which installer contains Visioneer Acuity. Visioneer Acuity is not available if it is not described in the download page for your scanner.

The instructions in this section only apply if the scanner you purchased included Visioneer Acuity on the installation disc. For all other scanners, please continue on to the instructions for adjusting options on the Advanced Settings Tab.

Click the drop-down arrow to choose the type of Acuity settings to use for the new scan configuration. The options are:

- **Do not use Acuity image processing**—scanning will not use the Acuity processing.
- **Default settings**—automatically selects the options your scanner can use with any scan mode (Black&White, Grayscale, and Color).

Select the options for scanning

- **AutoCrop to original**—select this option to let the software automatically determine the size of the item being scanned.
- **Straighten image**—select this option to have the software automatically determine if a page is skewed, then straighten its image. If the page is scanned at too great an angle, the image may not straighten correctly. In that case, re-scan the page.
- **Auto detect color**—determines if a document contains color or not and produces the appropriate scanned image. Instead of you having to change the scan settings from Color to Black&White and back again, the scanner can choose the correct settings automatically.
- **Skip blank originals**—recognizes when a page is blank and removes its image.
- **Rotate image**—select an option in this list to have the final image rotated when scanning is complete.
- **Flip back side**—select this option if you are scanning duplex pages that are calendar style orientation. This option will rotate the back side image 180 degrees from the front side. When scanning in duplex mode without this option selected, the back side image of calendar orientation pages will appear upside down in the final scan. This option does not automatically determine book page orientation versus calendar page orientation. If you have this option selected when scanning book orientation pages, the image for the back side of the page will appear upside down in the final scan. If you are scanning a batch of documents that contain both types of orientation, we recommend that you select Automatic in the Rotate image list.

- **Perform edge cleanup**—select this option to have the software remove any thin lines that may be around the edges in the scanned image. Edge Cleanup only applies if AutoCrop and AutoDeskew are selected so the software can determine where the edges are located. Therefore, selecting Edge Cleanup will also select AutoCrop and AutoDeskew. This option is only available when scanning in Black&White.

- **Despeckle**—speckles are small spots on an image that the scanner interpreted as a valid part of the document. The Despeckle option identifies these spots and removes them. This option is only available when scanning in Black&White.

- **Color dropout**—color dropout is the ability of your scanner to automatically remove a color from a scanned image. For example, if you are scanning a letter with a red watermark, you can choose to filter out the red so the scanned letter just shows the text and not the red watermark. Color dropout applies to Black & White or Grayscale scanning modes.

- **Bit depth reduction**—click the drop down menu and select an option from the list. The Bit depth reduction options are only available when scanning in black and white.
  - **Error diffusion, Bayer, and Halftone** patterns are the intentional application of noise (dithering) in the image to help alleviate banding when scanning in binary (black and white) mode. For example, if you scan a color photo in black and white, the image file will have large blocks of black and white and the image barely recognizable. Dithering the image creates a black and white image that is recognizable.
  - **Dynamic threshold** attempts to evaluate the scanned page and automatically adjust the brightness and contrast levels to produce the best quality image when scanning in black and white.

---

![Image of OneTouch Panel and scan configuration](image)

The Acuity icon on the top of the OneTouch Panel and on the scan configuration remind you that the scan will use the Acuity settings.

The summary of the scan settings also indicates Acuity settings.
VRS Settings Tab

The instructions in this section only apply if the scanner you purchased included Kofax Virtual ReScan (VRS™) on the installation disc. For all other scanners, please continue on to the instructions for adjusting options on the Advanced Settings Tab.

When Visioneer Acuity is installed the “Acuity Settings” tab will replace the “VRS Settings” tab in the Scan Configuration properties window. Uninstall “Visioneer Acuity Assets” from the Windows Control Panel then power cycle your scanner to show the “VRS Settings” tab.

When you first install the software, the Basic Features will be available and a button, Get VRS Pro!, will also be on the window. If you would like to purchase VRS Professional to be able to use the Professional Features of VRS, click the Get VRS Pro! button.

Click the drop-down arrow to choose the type of VRS settings to use for the new scan configuration. The options are:

- **Do not use VRS processing**—scanning will not use the VRS processing.
- **Default settings**—automatically selects the options your scanner can use with any scan mode (Black&White, Grayscale, and Color).

**The Basic Features are:**

- **AutoCrop**—select this option to let the software automatically determine the size of the item being scanned.
- **AutoDeskew**—select this option to have the software automatically determine if a page is skewed, then straighten its image. If the page is scanned at too great an angle, the image may not straighten correctly. In that case, re-scan the page.
- **AutoBrightness**—sets the brightness to achieve the best balance between the document’s background, foreground, and highlighted areas. This option is not available when scanning in Color.
- **Edge Cleanup**—select this option to have the software remove any thin lines that may be around the edges in the scanned image. Edge Cleanup only applies if AutoCrop and AutoDeskew are selected so the software can determine where the edges are located. Therefore, selecting Edge Cleanup will also select AutoCrop and AutoDeskew. This option is only available when scanning in Black&White.
■ **Despeckle**—speckles are small spots on an image that the scanner interpreted as a valid part of the document. The Despeckle option identifies these spots and removes them. This option is only available when scanning in Black&White.

**Technical Note**

The following features are disabled in OneTouch when the corresponding VRS feature is enabled.

■ **Scan Settings** tab—Brightness and Contrast are disabled when AutoBrightness is selected on the VRS Settings tab.

■ **Page Settings** tab—Straighten image, AutoCrop to original, and Edge cleanup are disabled when AutoCrop, AutoDeskew, or Edge cleanup is selected on the VRS Settings tab.

**The Professional Features**

If you upgrade your scanner’s VRS software to the VRS Professional version, the Professional Features shown at the bottom of the window become active.

■ **Advanced Clarity**—produces a clear, legible image even for documents that have complex or textured backgrounds, such as graph paper, blueprints, and security paper. The Advanced Clarity option identifies the text and drawings in the foreground and produces a scan image that keeps the background from obscuring them. This option is only available when scanning in Black&White.

■ **AutoOrientation**—recognizes text on the page and rotates the image 90, 180, or 270 degrees so the text is right side up. The AutoDeskew option must also be selected with the AutoOrientation option.

■ **Auto Color Detect**—determines if a document contains color or not and produces the appropriate scanned image. Instead of you having to change the scan settings from Color to Black&White and back again, the scanner can choose the correct settings automatically.

■ **Blank Page Deletion**—recognizes when a page is blank and removes its image.

■ **Background Smoothing**—sometimes a document with a background color on the page will produce a scanned image that has small imperfections in the color. This option recognizes a document’s background color and makes sure it is a smooth, solid color. Background Smoothing is not available for Black&White scan configurations.
Advanced Settings Tab

Use the Advanced Settings tab to set color correction options for Color or Grayscale scanning. Drag the sliders to the left and right to change the color settings. As you do, the image changes to show the effects of the new settings.

- **Color saturation**—the strength or purity of a color. This option is only available when the selected scan mode is Color.
- **Color hue**—the color your eyes see as reflected from the image. This option is only available when the selected scan mode is Color.
- **Gamma**—is the tone curve and the starting point for image enhancement. As you raise or lower the Gamma value, the values at which saturation, hue, brightness and contrast affect the image are changed. It is recommended that you keep the default Gamma value or adjust this setting before adjusting the other options. This option is available for both Color and Grayscale scanning.

Redaction Settings Tab

Use the options on the Redaction Settings tab to remove a specified area in the scanned image.

Please refer to the technical note, at the end of this section, for information about how this setting works with other options in the OneTouch Scan Configuration you are modifying.
Enable redaction—select this option to enable redaction when scanning. You might use this option if you want to remove a logo or image that appears on each page that you are scanning. You can choose what color to fill in the redacted area in the scanned image, and set multiple areas. If you are scanning in Duplex mode, you can specify the area separately for the front and back side of the pages.

Click Add to add a line item to the area list in this window. You can redact multiple areas from the scanned image, click the Add button again to continue adding line items to the list. Select an item in the list then click the Remove button to remove the specified redaction area from the list.

Side—click once on the word Front to show the Side option list. If you are using a simplex (one-sided) scanner, only the Front option will be available. If your scanner supports duplex (two-sided) scanning, the options Front, Back, and Both will be available in the list.

- Front—this is the Simplex side of the page. The area(s) specified for the Front will only apply to the Simplex side of the page when scanning in Duplex. Therefore, if you scan 4 double-sided pages, the resulting image file(s) will have redacted areas on pages 1, 3, 5, and 7.

- Back—this is the Duplex side of the page. The area(s) specified for the Back will only apply to the Duplex side of the page when scanning in Duplex. Therefore, if you scan 4 double-sided pages, the resulting image file(s) will have redacted areas on pages 2, 4, 6, and 8.

- Both—select this option if you want to specify an area that appears in the same place on both sides of the page, such as a company logo, so you don’t have to specify the same area separately for both the front and back.
Click one time on the default value, 0.00 in each field, to enable the control box for you to input the start position and redaction area size. The units of measurement is displayed on the lower right corner next to the Paper size field.

- **From left**—input the upper-left corner start position measured from the left-side of the page.
- **From top**—input the upper-left corner start position measured from the top of the page.
- **Width**—input the width of the area to be removed.
- **Height**—input the height of the area to be removed.

**Color**—this color field shows the selected fill color for the redacted area(s). When the software removes the area you specify, it fills the area with the color you have selected here. To change the color, click the artist palette button to open the Windows color palette. Select the color you want then click on **OK**. The color you selected will now display in the **Color** field on the Redaction Settings tab.
**Preview**—this color field shows the actual color that will fill the redaction area in the final scanned image. When scanning in color, the Preview field will match the Color field. When scanning in Grayscale, the preview field will show the gray version of the color you selected, and that color will be in the final scanned image. When scanning in Black&White, the preview field will display black or white depending on the darkness of the color you selected, and the final image will have the redacted area(s) be black or white.

<table>
<thead>
<tr>
<th>Color:</th>
<th>Color:</th>
<th>Color:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Preview</td>
<td>Preview</td>
</tr>
<tr>
<td>Color:</td>
<td>Color:</td>
<td>Color:</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview</td>
<td>Preview</td>
</tr>
</tbody>
</table>

**Technical Note**

The options on the Page Settings tab will affect the redaction options as described below:

- **On the Page Settings tab, click the name **inches** or **mm** to toggle between the two units of measurement. When you click back on the Redaction Settings tab, the lower-right corner displays the Paper size in the units of measurement you selected.**

- **Make sure the page size selected on the Page Settings tab is correct for the documents you are scanning, otherwise the redaction may not occur in the correct area.**

- **If **Color dropout** is selected, redaction occurs after the color specified is removed from the image. For example, if you selected Red as the color dropout, but then specify red for the redaction region, the final image will have the redacted region filled with gray when scanning Grayscale, or black or white when scanning in Black&White.**

- **If **Autorotate 90** is selected, redaction occurs after the page has been rotated. When inputting the position and area for redaction, use the measurements of the page in the landscape position.**
**FILE FORMATS**

The available file formats, in the **Select format** panel, are based on the selected destination for scanning. Most of the format icons have a right-click menu to select file format specific options, or choose additional formats that are not represented in the panel by default.

The format names in the **Select format** panel indicates the file type extension for the scanned file.

---

**Create Single Image Files**

The TIFF and PDF formats, as well as the text formats, support multiple page documents in a single file. If you are scanning as a TIFF or PDF format, or as one of the text formats, and want one file created for each image scanned, select **Create single image files**. Note that this option is automatically selected and disabled if you have selected a format that only supports single pages, such as BMP, PNG, GIF, or JPG.

---

**Image Formats**

Select an image file format for photos, artwork or other documents that you want to save as images. Right-click on the BMP icon to access the GIF and PNG image formats. When you select either of these formats, the format panel will change the BMP icon to the selected image format icon.

---

**BMP**—the *.bmp (bitmap) format is generally used when you want to do additional image processing, such as photo touch-up or color correction, as very little image compression is used when creating the file. When scanning in color or grayscale, BMP scans result in the largest file size of the image formats.
To select a JPEG file size:

1. Select JPG as the page format.
2. Right-click on the JPG icon.
3. Choose the file size/image quality option for your scanned images.
   - **Minimize Size**—smallest file size, lowest image quality.
   - **Normal**—medium file size, some loss of image quality.
   - **Maximize Quality**—largest file size, minimal loss of image quality.

   Your selection pertains only to the button currently selected on the OneTouch Properties window. Other buttons that have JPG selected as the file format are not affected, so you can set the JPG file size/image quality independently for each button.

4. Click **OK** or **Apply** on the OneTouch Properties window.

Right-click on the PDF format icon to change the image quality or select the option to make the scanned PDF file PDF-A compliant.
To select a PDF file size:
1. Select **PDF** as the page format.
2. Right-click on the **PDF** icon.

3. Choose the file size/image quality option for your scanned images.
   - **Minimize Size**—smallest file size, lowest image quality.
   - **Normal**—medium file size, some loss of image quality.
   - **Maximize Quality**—largest file size, minimal loss of image quality.

   Your selection pertains only to the button currently selected on the OneTouch Properties window. Other buttons that have PDF selected as the file format are not affected, so you can set the PDF file size/image quality independently for each button.
4. Click **OK** or **Apply** on the OneTouch Properties window.

**Text Formats**

Selecting the text format option also selects OCR processing as an automatic step for scanning. Therefore, when you scan a document with the text format selected, the text portions of the document are automatically converted to editable text. The text format icon has several file formats available, depending on the Destination Application you select.

For the text file formats to be available in OneTouch, the OneTouch OmniPage Module must be installed. The OneTouch OmniPage Module is automatically installed when you install OneTouch from the installation disc.
To select a file type for the text format:
1. Select the Destination Application.
2. Right-click on the text format icon.

The menu options depend on the type of Destination Application you select.

3. Choose the file type that you want for the text format.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Text</td>
<td>The .txt file format. Text with no formatting; used by the standard Microsoft Notepad application.</td>
</tr>
<tr>
<td>Word Document</td>
<td>The .doc file format used by Microsoft Word.</td>
</tr>
<tr>
<td>Comma Delimited</td>
<td>The .csv file format; used for database or spreadsheet data with fields, when the document is converted into editable text the fields are maintained.</td>
</tr>
<tr>
<td>Excel Spreadsheet</td>
<td>The .xls file format used by Microsoft Excel.</td>
</tr>
<tr>
<td>HTML Document</td>
<td>The .htm file format used to create web pages.</td>
</tr>
<tr>
<td>Searchable PDF</td>
<td>The .pdf file format used by Adobe Acrobat. This format converts scanned text into PDF with an invisible text layer for searching.</td>
</tr>
</tbody>
</table>
sPDF and nPDF formats

Additional options are available on the menu for the sPDF and nPDF text formats. The three image quality settings are:

- **Minimize Size**—smallest file size, lowest image quality.
- **Normal**—medium file size, some loss of image quality.
- **Maximize Quality**—largest file size, no loss of image quality.

**Note:** Documents scanned with nPDF and sPDF automatically include OCR processing. If the processing does not recognize a large number of the text characters in the document, change the image quality setting and re-scan the document. For example, change from **Minimize Size** to **Normal** to see if the text recognition improves.

- **Use MRC**—MRC stands for Mixed Raster Content. MRC is an advanced technique for optimizing the image quality of scanned documents. Without MRC, the scanned image is produced using a single process to capture and display the image on the computer screen, even if the document contains both text and graphics. With MRC, the image is produced using separate processes for text, graphics, and other elements on the document page. The result is clearer graphics and sharper text characters. Scans with Use MRC selected may take slightly longer to complete the processing. Select **Use MRC** for documents with harder-to-read text or lower-quality graphics to get the best possible scan output image. The Use MRC option is available for sPDF and PDF.

**Configure Before Scan**

You can set up the scanner so that, when you press a button or click it on the Button Panel, the TWAIN scanning interface opens before the scanning starts. You can then use the interface to change the Resolution, Scan Mode, and other settings. When you scan, the scanned image will still be sent as the file type and to the same Destination Application already selected in the OneTouch Properties window for that button.

**Technical Note:** flatbed and single page sheetfed scanners can use the option Configure Before Scan to scan multiple pages and have them appear in one file.

Please see the TWAIN scanning guide on the installation disc for instructions on using the TWAIN interface. You can also click the Help button in the TWAIN interface to open the instructions in an Internet browser.

1. Open the OneTouch Properties window.
2. Select the scan configuration **Configure Before Scan**.

3. Click **OK** or **Apply** on the OneTouch Properties window.

### Scan Using Configure Before Scan

1. Put a document in the scanner.
2. Click the button you set up to use Configure Before Scan.
3. The TWAIN Interface opens.
4. Choose your scan settings, such as the Picture Type of Color, Grayscale or Black & White, Resolution in DPI, and Page Size.
5. Click the **Scan** button on the TWAIN Interface.
6. The item is scanned. When finished, click the **Done** button and the image will be sent to the Destination Application specified in the OneTouch Properties window.

### Flatbed and Single Page Scanners—Creating Multiple Page Files

You can use Configure Before Scan to create multi-page documents from individually scanned pages.

**Note:** Using the Configure Before Scan option to scan multiple pages does not apply for page formats BMP and JPG. Please make sure the page format on the OneTouch Properties window is set to TIFF, PDF, or one of the Text formats. Make sure the option Create single image files is not selected. Please see page 26 for instructions on changing the file settings.

1. Put a document in the scanner.
2. When the TWAIN Interface opens, select the appropriate scan settings for your document.
3. Click the **Scan** button on the TWAIN Interface.
4. After the Scanning Progress bar closes, place the next page in the scanner.
5. Continue until you have scanned all the pages in your multi-page document.
When you’re finished scanning, click the **Done** button on the TWAIN Interface.

All the scanned pages will be sent to the Destination Application set in the OneTouch Properties window.

## Canceling a Configure Before Scan

1. Click **Cancel** in the scanning progress window.

2. The following window will open asking if you want to cancel the entire job.

   - **Yes**—scanning stops and all pages scanned in this batch, up to this point, will be deleted. The TWAIN interface will close and you can restart your scan from the beginning.
   - **No**—scanning stops, but all pages scanned in this batch, up to this point, are not deleted and the TWAIN interface remains open. You can place a new page in the scanner, adjust the TWAIN settings for it, then click the **Scan** button in the TWAIN interface to continue scanning. At the end of the scanning batch, all pages from the first portion of the scan and second will be sent to the Destination Application.

## Scanning with Job Separation

Use job separation to have OneTouch create a new file each time a separator is detected when scanning a multiple page batch. For example, if you want to scan financial statements from several different banks, you can place a stack of statements in the scanner and OneTouch will separate each statement into a different file based on your selected job separator.

1. Open the OneTouch Properties window.
2. Select the Destination Application, File Format, and Scan Configuration applicable to your scanning batch. Make sure the option **Create single image files** is not selected. If this option is selected, the job separation features on the **Options** tab will be disabled.

![Options Tab](image)

3. Click on the **Options** tab in the OneTouch Properties window.

4. Click on the down arrow next to the **Select Button** list to select the button you want to modify.

5. Click on the option **Use job separator when scanning multiple pages**.

![Options Tab](image)

6. Select one of the three job separation options:

   **When a blank page is detected**—select this option to have a new file created each time a blank page is detected in the stack of pages being scanned. The blank page is discarded from the scanned image and the new file starts with the next page in the document stack. Place a blank page, in the document you are scanning, at each place where you want a new file created when scanning is complete.

   When you are scanning in Duplex mode, both sides of the page must be blank for this job separation option to work.
● **Sensitivity**—you can adjust the sensitivity level of the blank page detection. For instance, depending on the paper weight, color mode, or image processing options selected, you might get varying results. Changing the sensitivity level allows you to fine-tune the accuracy of the blank page detection.

**When the number of images reaches**—input the maximum number of images you want in the scanned file. The scanner will create a new file each time that number is reached.

Note that when scanning in duplex, the number of images detected is twice the number of pages scanned. For example, if you input “5” in the field and scan 10 pages, 20 images are captured, and you will get 4 separate files with 5 images in each file.

**When barcode is detected**—select this option to create a new file each time a particular barcode is detected. Input the barcode metadata into the field and a new file will be created when a barcode with this metadata is detected.

If the field is left empty then any detected barcode will cause a new file to be created at that point.

In order for this option to be used, barcode detection must be enabled in the TWAIN interface. See Use TWAIN Driver PLUS Settings on page 14 or Configure Before Scan on page 30 for information on configuring the TWAIN interface.

7. When you are done making changes, click on OK to save the changes and close the window.

8. Place your documents in the scanner and start scanning.

When scanning is finished, each file will be sent to the destination location or application you have selected on the button tab.

**Technical Note**

■ **Single page scanners**—if you have a single sheetfed mobile scanner, or a flatbed scanner, you can use Configure Before Scan to create files with multiple pages.

■ **Instant delivery**—when Instant delivery is also selected on the Options tab, each file will be sent as it is created.

■ **Page Settings tab**—the options on the Page Settings tab, in the Scan Configuration Properties window will affect the job separation options as described below:

● **Skip blank originals**—the Sensitivity you set for this feature is the one that is used when scanning. The sensitivity level you set in the Options tab will be ignored.

● **Skip blank originals**—When you are scanning in Simplex mode and the selected job separator is **When a blank page is detected**, the job separation occurs first and a new file will be created each time a blank page is detected. If you want a single file created with the blank page discarded, deselect the job separation feature on the Options tab.

● **Skip blank originals**—if you select **When the number of images reaches**, and input a number in the control box, any blank pages will be discarded first, and then the number of images scanned will be counted. For example, if you scan 12 pages and 3 are blank, the total number of images counted for the job separation will be 9 not 12.
SELECTING OCR OPTIONS FOR TEXT FORMATS

The OneTouch OmniPage Module must be installed on your computer in order to use the OCR options with the OneTouch software and your scanner. The OneTouch OmniPage Module was automatically installed when you installed your driver from the installation disc.

**Note:** the OCR options apply globally to all the OneTouch Destination Applications that perform OCR. For example, if you select the OCR options for Adobe Acrobat, they also apply to WordPad.

1. Select a Destination Application that has one of the text format file types as the page format, such as Microsoft Word or WordPad.
2. Right-click on the page format icon to see the menu.
3. Choose **OCR Options** from the menu.

The OCR Properties window opens with the OCR tab selected.
The OCR Tab

The options shown on the OCR tab window are for spellchecking scanned text, replacing missing or unrecognized characters, and setting the speed and quality levels of the OCR processing.

Choose the options you want from the OCR window. Click OK or Apply. These options will apply to the OCR processing when you select any text format as the file format.

- **Languages in Document**—click on the language(s) in the list that correspond to the languages in the documents to be scanned. You can click on multiple languages. These are the languages that will be recognized during the OCR process. For faster and more reliable language recognition, select only the languages in the documents.

- **Use languages and dictionaries to improve accuracy**—select this option to automatically check the validity of the recognized words. An OCR engine looks at each letter or symbol on the page individually, then “guesses” what the letter or symbol is based on the shape. Therefore, the OCR engine may have more than one guess for a particular letter or symbol, a “best guess”, a “second-best guess”, and so on. This option tells the OCR engine to look through the dictionary to validate its best guess for the letters in that word; if its best guess is not in the dictionary, it checks for the second-best guess, and so on.

For example, if the word “house” appears in the original document but the OCR engine is 75% sure that the “o” is actually an “a”, the finished document would have the word “hause”. Turning this option on tells the OCR engine to look at the other letters in the word, check to see which version of the word is in the dictionary, and output the correct word “house” in the final document.

The OCR engine does not automatically correct misspelled words that were present in the original document. When dictionaries are selected, the terms in those dictionaries are used to check the spelling. If this is option is not selected, User Dictionaries and Professional Dictionaries cannot be selected.
**User Dictionary**—a user dictionary is your personal dictionary with words that you want the OCR engine to reference for better accuracy when converting the document into editable text. For example, if you scan documents with highly technical terms or acronyms not found in typical dictionaries, you can add them to your personal dictionary. You can also add names that you expect to be in the documents too. This way, as the OCR process recognizes each letter or symbol, there is a higher chance that the technical term or name will be correctly spelled in the final document. You can create multiple user dictionaries. See the section Creating Your Own Dictionaries on page 37.

Click the menu arrow and select a user dictionary from the list.

If you select [none] as the user dictionary, the text will be validated using the terms in the dictionaries for the selected languages, as well as any professional dictionaries if they are selected.

The label [current] is next to the currently-select user dictionary.

**Professional Dictionaries**—these are legal and medical dictionaries containing highly specialized words and phrases. The options are: Dutch Legal, Dutch Medical, English Financial, English Legal, English Medical, French Legal, French Medical, German Legal, and German Medical. Select the appropriate dictionary for the OCR engine to use to validate the scanned text.

**Reject Character**—this is the character that the OCR process inserts for an unrecognizable text character. For example, if the OCR process cannot recognize the J in REJECT, and ~ is the reject character, the word would appear as RE~ECT in your document. The ~ is the default reject character.

Type the character you want to use in the Reject Character box. Try to choose a character that will not appear in your documents.

**Missing Character**—this is the character that the OCR process inserts for a missing text character. A missing text character is one that the OCR process recognizes, but cannot represent because that character is not available for the selected language. For example, if the document contains the text symbol “Ç” but the OCR process cannot represent that character, then every place “Ç” appears, the OCR process substitutes the missing character symbol. The caret (^) is the default symbol for the missing character.

Type the character you want to use in the Missing Character box. Try to choose a character that will not appear in your documents.

**Recognition Quality**—drag the slider to the left or right to set the degree of accuracy for the OCR process. The higher the accuracy, the longer the OCR process requires to complete. For clean, highly-legible documents, you can set the recognition quality to a lower level to produce results more quickly.

### Creating Your Own Dictionaries

1. Open any word processing program, such as Microsoft Word, WordPad, or Notepad.
2. Create a new document in the word processing program.
3. Type each word you want in your new dictionary, followed by a carriage return.

Here is an example of what the text file might look like:

- OneTouch
- OmniPage
- wysiwyg
- jpeg
- bmp
4. Save the document in the .txt format and give the file the name that you want for the dictionary.

5. Now open the OCR Options window.

6. On the OCR Options window, click the button next to the menu arrow.

7. The User Dictionary Files window opens and shows the available dictionaries.

8. Click Add New.

9. Click the drop-down arrow for Files of type and choose Text Files (.txt).

10. Select the file you just created for your user dictionary and click Open.

11. The text file now appears on the list of user dictionaries that you can use.
12. Select a dictionary and click **Set As Current** to set it as the current dictionary for spellchecking. The label [current] is added to the name.

   If you don’t want to use any user dictionaries for spellchecking, click [none] at the top of the list.

   To remove a dictionary from the list, select it and click **Remove**. This only removes the dictionary from the list. It does not affect the original text file you created with the list of words.

**Editing User Dictionaries**

1. On the Add New window, select the dictionary to edit and click **Edit**.

![User Dictionary Window](image)

2. To add a new word to the list, type it in the box for **User Word** and click **Add**.

   To delete a word from the list, select it and click **Delete**.

3. To import a list of words from another text file, click **Import**.

![Import User Dictionary](image)

4. Select the file that has the words you want to add to your user dictionary.

   Importing will add the entire list of words in a file to the user dictionary.

5. Click **Import**. The file’s words will be added to your user dictionary list.
6. To export a user dictionary so it can be used by another program, select the dictionary on the User Dictionary Files list and click **Export**.

7. Select the dictionary file to export and click **Save**.

The file is exported as a formatted dictionary with the .ud filename extension so it can be opened by other programs.

**The Format Tab**

The options on the **Format** tab window are for setting the input and output formats for the scanned documents.

Click the **Format** tab and choose the options you want for both the input and output formats.
Input Format Options

- **Automatic**—choose this option to let the OCR process determine the format of the pages. Typically you select this option when the document has different or unknown types of layouts, pages with multiple columns and a table, or pages containing more than one table. The OCR process will then determine if text is in columns, an item is a graphic or text, and tables are present.

- **Single column no table**—choose this option if the document contains only one column of text and no tables. Business letters are normally in this form. You can also use this option for documents with words or numbers in columns if you do not want them placed in a table or decolumnized or treated as separate columns.

- **Multiple columns, no table**—choose this option if some document pages contain text in columns and you want it kept in separate columns, similar to the original layout. If table-like data is encountered, it is placed in columns, not in a gridded table.

- **Single column with table**—choose this option if your document contains only one column of text and a table. The table will be placed in a grid in the Destination Application you have selected. You can later specify whether to export it in a grid or as tab-separated text columns.

- **Spreadsheet**—choose this option if the entire document consists of a table that you want to export to a spreadsheet program, or have treated as a table. No flowing text or graphics will be detected.

Output Format Options

- **Automatic**—the document will be formatted as close to its original as possible. The OneTouch software will adjust its settings to the most appropriate for the document being scanned in order to match your selected output format. The output quality will be maximized and the processing time minimized.

- **No formatting**—the document will be plain text, one column, left-aligned in a single font and font size. You can then export the plain text to nearly all file types and target applications.

- **Retain fonts and paragraphs**—this output format retains the font and paragraph styling, including graphics and tables without columnized text, but does not retain layout formatting. If the document is being scanned as an Excel spreadsheet, each detected table or spreadsheet becomes a separate worksheet, while other content is placed on the last worksheet.

- **Flowing page**—this format preserves the original layout of the pages, including columns. This is done wherever possible with column and indent settings, but not with text boxes or frames. Text will then flow from one column to the other, which does not happen when text boxes are present.

- **True page**—this output format uses absolute positioning on the page to keep the original layout of the pages, including columns. This is done with text, picture and table boxes and frames. True Page is the only choice for documents scanned with the PDF format. It is not available for the TXT, RTF, CSV, or XLS formats.

- **Spreadsheet**—this output format produces results in a tabular form with each page becoming a separate worksheet. The worksheets can then be opened in a spreadsheet application. The Spreadsheet output option is only available for documents scanned with the XLS format.

These options will now apply to the OCR processing when you select any text format as the page format.
OPEN SCANNED DOCUMENT(S)

Select the destination Open Scanned Document(s) to have the scanned document open automatically when scanning is complete.

**Supported file types**—all file formats are available when scanning to the Open Scanned Document(s) destination. Note that text file formats are only available if an OCR module or application is installed. Please refer to Text Formats on page 28 to see a list of text file formats that are available when OCR is installed.

**Destination type**—the Open Scanned Document(s) destination is classified as a “Document Management Link”. To make it available in the destination list, you must select Document management on the Options tab in the OneTouch Properties window.

Technical Note

- If there is no application installed for the file format you selected, the OneTouch Link Log Viewer will open when scanning is finished showing the failure. You can double-click on the log failure to open the detail view of the failed transfer.

  For example, if you select PDF as the file type a PDF viewer application must be installed to open the file.

  Either install an application for that file type, or associate an application in the Windows Explorer folders option, please refer to your Windows documentation for instructions on associating file types.

- When scanning to multiple destinations, the scanned file is still sent to the other selected destination application(s) in OneTouch.
Transfer to Storage

With Transfer to Storage, you can scan documents and save them in a folder in one step.

Supported file types—since the files are saved directly to a folder on the computer or server, all file formats in OneTouch are available. Note that text file formats are only available if an OCR module or application is installed. Please refer to Text Formats on page 28 to see a list of text file formats that are available when OCR is installed.

Destination type—the Transfer to Storage destination is classified as a “Storage Link”. To make it available in the destination list, you must select Storage and CD-R/W on the Options tab in the OneTouch Properties window.

Setting the Folder and Options from OneTouch

In the OneTouch Properties window, select Transfer to Storage as the Destination Application for scanning.

- Click the Properties button to open the OneTouch Link Properties for Transfer to Storage. From this window, you can change the global default storage location and options.

On initial installation of OneTouch, all scan configurations use these settings. When you create new configurations, the default settings will also match what you have selected here. If you modify the storage options in an individual configuration, changing the options in this Link Properties window will no longer update to the configurations you modified.
Click the **New, Copy**, or **Edit** button to open the Scan Configuration Properties window. Click on the **Storage Options** tab and use this window to set a configuration to scan to a different folder than the one selected in the Link Properties window.

Changing the options in this window only affects the configuration you are creating or modifying. All other configurations will retain their settings for this destination.

**Storage layout**

- **All documents are in the root**—the scanned documents are saved in the root of the folder specified in the Storage location.

- **Documents are put into folders by month, week, or type**—folders are created based on your selection (month, week, or file type) and the scanned documents are saved in those folders. New folders are created for each month and week so you can keep track of when you scanned the documents.

**Storage location**

- This is the location on the computer or network where the scanned documents will be saved. Click on the **Browse** button to change the location by browsing through your Windows folder list, or type a location directly into the input field. You can select a local folder, or a folder on a server or mapped drive.

- **Prompt for each batch**—When this option is selected, a window will appear after each batch is scanned, prompting the user to select a location to save the images.

**Open storage folder when scan is complete**

- Select this option to have the folder, specified in the **Storage location**, open when scanning is complete and the image has been transferred to that location. If you have selected a **month**, **week**, or **type** grouping option, the folder that opens will be the grouping option you selected.

**File lock**

- Select this option for the file to be named with a .tmp extension while it is being transferred to storage. After the file has been transferred completely, it will be renamed with the appropriate file extension.
Setting the Folder from Windows

When OneTouch was installed, a storage option was added to the right-click menu of your Windows folders. This menu option allows you to set the Transfer to Storage folder location without opening OneTouch first.

1. Right-click on the folder you want set as the scan destination.
2. Hover the mouse cursor over the **Set as scan destination** option and the sub-menu will open to the right. Click on the setting you want the Storage location to be updated with.

- **For all configurations**—select this option to have the storage location, in all scan configurations Storage Options tabs, updated to use this location. Note that the storage Link Properties location will also update to use this location.
- **For new and default configurations**—select this option to have the OneTouch Link Properties storage location updated. Any scan configurations that you have not previously updated, with custom storage locations, will also use this location.
- **For configuration used by a button**—when you select this option, another sub-menu will open to the right. The sub-menu will contain a list scanner buttons that are currently set to scan to the Transfer to Storage destination. Select the button you want updated to use this location. This option modifies only the scan configuration that is assigned to the button you select. If you have multiple OneTouch 4.6 scanners installed, the first sub-menu will show a list of the currently connected scanners for you to select which scanner to update.
  
  Note that this option is disabled if there is no scanner plugged in and turned on.

Scanning to Multiple Folders

When archiving documents with Transfer to Storage option, you can scan the documents to different folders. For example, one folder might be for “Business Receipts,” a second folder might be for “Personal Receipts,” and a third folder might be for “Annual Receipts.”
To scan to multiple folders, you create multiple configurations, each with a different storage location for the scanned documents. Scan one set of documents using the scan configuration with the appropriate storage location for that set. Then switch to another scan configuration and scan the next set of documents to store them in their folder.

**Setting Up Multiple Folders for Transfer to Storage**

1. Using Microsoft Windows, create the folders that you want to use for storing scanned items.
2. Open the OneTouch Properties window.
3. Select **Transfer to Storage** as the Destination Application.
4. Click the **New** button.

![Scan Configuration Properties dialog box](image)

The Scan Configuration Properties dialog box opens.

5. To help you remember which folder it is, give the new configuration a name that indicates the folder name, such as “Business Receipts.”
6. Click the **Scan Settings**, **Page Settings**, and **Advanced Settings** tabs, and select the settings you want.
7. Click the **Storage Options** tab.

![Storage Options tab](image)

8. Click the **Browse** button.
9. Select the folder you created for storing the scanned documents.

![Select location for storing documents]

10. Click **OK**. The selected folder will now be set as the Storage location, such as “Business Receipts.”

![Advanced Settings]

11. Click **OK**. The new configuration is now listed as a Transfer to Storage configuration.

12. Repeat the process to create additional new configurations, such as one named “Personal Receipts.”

**Note:** Make sure to designate *separate* folders as the Storage Locations for each new configuration.
13. You will now have multiple configurations set up for the **Transfer to Storage** destination, and each configuration scans documents to separate folders.

14. Now select a scanner button for each new configuration. Click **Apply** to set that button for that configuration.

**Multi-Function scanners—Scan to multiple storage folders:**
1. Insert the document you want to scan to storage.
2. Start scanning with the first button that you set to scan documents and transfer to storage.
3. When scanning is complete, insert the next set of documents in the scanner, then press the second button you set to scan documents and transfer them to storage.
4. When scanning is finished, the documents are stored in the two separate folders.

**Single Function scanners—Scan to multiple storage folders:**
1. Open the OneTouch Properties window.
2. Select one of the configurations you created for storage.
3. Click **OK**. The OneTouch Properties window closes.
4. The OneTouch panel will show the name of the configuration.
5. Scan the documents you want to store.
   The documents are scanned to the folder specified for the configuration.
6. When scanning is finished, open the OneTouch Properties window again and select the other configuration you created for storage.
7. Click **OK**.

The OneTouch panel will show the name of the other configuration.

8. Now scan the next set of documents.

When scanning is finished, the two sets of documents are stored in the two separate folders.

---

**Burn to CD-ROM**

If you have a CD burner attached to your computer, you can scan directly from your scanner onto a CD. This feature is available only on computers running Windows version XP or later.

**Supported file types**—since the files are going to be burned to a CD, all file formats in OneTouch are available. Note that text file formats are only available if an OCR module or application is installed. Please refer to **Text Formats** on page 28 to see a list of text file formats that are available when OCR is installed.

**Destination type**—the Burn to CD-ROM destination is classified as a “Storage Link”. To make it available in the destination list, you must select Storage and CD-R/W on the Options tab in the OneTouch Properties window.

1. Open the OneTouch Properties window.

2. Select **Burn to CD** as the Destination Application.

3. Choose a File Format and a Scan Configuration.

4. Click **OK**.

5. Now start scanning using the scanning button you set to scan and burn to a CD.

The scanner will start scanning. When finished, be saved to the Windows temporary location for CD files. An information bubble will appear in the Windows notification area telling you that there are files waiting to be burned to CD.
6. When you are ready to burn the files to a CD, open the OneTouch Properties window, select **Burn to CD** and then click the **Properties** button.

![OneTouch Properties window](image)

7. Make sure a blank CD is in the CD burner.

8. Click the **Burn to CD** button. The CD burner begins and your scanned documents are written to the CD. If other files are also waiting in this location, they will get written with the OneTouch files on the CD.

**Printer or Fax**

The availability of printers and/or faxes in the OneTouch destination list depends on whether or not you have printers or faxes configured in Windows. Please refer to the Windows documentation, or your printer or fax documentation, for setting up printers and faxes.

**Supported file types**—only the BMP file format is available, when scanning to a printer or fax, as only uncompressed data can be sent to these devices.

**Destination type**—Printing and Faxes are classified as “Device Links”. To make them available in the destination list, you must select Fax and Print on the Options tab in the OneTouch Properties window.
The Properties button will be disabled in OneTouch as there are no global properties for this type of destination.

Select a printer or fax device, in the Select destination list, then open a Scan Configuration to modify the settings for the device you selected.

Click on the **Device Settings** tab and use the options on this tab to select settings for the device.

- **Fit to page, reduce image if necessary**—if the scanned image is too big to be printed or faxed on a single page, the image will automatically be reduced to fit the page.
- **Actual size, crop image if necessary**—if the scanned image is too big to be printed or faxed on a single page, the image will automatically be cropped around its edges to fit on the page.
- **Center image on page**—the image will be printed in the center of the page instead of at the top left corner.
- **Maintain aspect ratio**—the aspect ratio is the length-to-width relationship of the image's dimensions. Select this option so the image's relative proportions remain constant.
- **AutoRotate image for best fit**—if the image is a Landscape format and the device is printing in the Portrait mode, or vice versa, rotate the image to fit on the page.
- **Collate copies**—if you are printing more than one page, collate the copies. Enter the number of copies in the Copies box.
- **Advanced**—click to see additional settings for the device. The dialog box that opens is specific to the device. For example, if the device is your printer, the dialog box is your printer's setup settings.
When scanning to multiple printers and/or faxes, select the specific device you want to configure the Advanced features for, from the list before clicking on the Advanced... button.

**PaperPort**

In the OneTouch Properties window, select **PaperPort** as the Destination Application for scanning.

**Supported file types**—all image file formats are available when scanning to PaperPort. The sPDF and nPDF text file formats are only available when the OmniPage software or OneTouch OmniPage module is installed. Please refer to **Text Formats** on page 28.

**Destination type**—the PaperPort destination is classified as a “Document Management Link”. To make it available in the destination list, you must select Document management on the Options tab in the OneTouch Properties window.
- Click the **Properties** button to open the OneTouch Link Properties for PaperPort. From this window, you can change the default folder location and options.

On initial installation of OneTouch, all scan configurations send the scanned document to the folder selected in this window. When you create new configurations, the default settings will also match what you have selected here. If you modify the options in an individual configuration, changing the options in this Link Properties window will no longer update to the configurations you modified.

- Click the **New**, **Copy**, or **Edit** button to open the Scan Configuration Properties window. Click on the **PaperPort** tab and use this window to set a configuration to scan to a different folder than the one selected in the Link Properties window.

Changing the options in this window only affects the configuration you are creating or modifying. All other configurations will retain their settings for this destination.

![PaperPort OneTouch Link Properties window](image1)

![Scan Configuration Properties window - PaperPort tab](image2)

**Select the destination folder for Scanned Documents**

- Select a folder to send the scanned document(s) to when scanning to the PaperPort destination.

The list of folders in this window are from the PaperPort Folder Manager. Use the PaperPort Folder Manager to add or delete folders, add other drives and network locations to this list. You cannot add new folders from the OneTouch PaperPort configuration windows.
Scan to the current PaperPort folder

- Select this option to have the scanned document(s) sent to the currently selected folder in the PaperPort application.

The PaperPort software must be open, before scanning, for the scans to be sent to the selected folder in the PaperPort folder pane. If PaperPort is not open, this option is ignored and the scanned file is sent to the folder selected in either the OneTouch Link Properties or Scan Configuration window for PaperPort.

Click the folder icon to open or close the folder list in PaperPort.

These are the folders that are available in the OneTouch PaperPort configuration windows. Press F1 on your keyboard to open the PaperPort help file for instructions on managing this folder list.

The selected folder in this list is where the scanned file will be saved when PaperPort is open and the OneTouch option Scan to the current PaperPort folder is selected.

**SHAREPOINT**

The SharePoint destination link allows scans to be sent directly to a SharePoint site from OneTouch. Please contact your SharePoint site administrator for the server information you need to configure this link. Alternatively, have your site administrator or IT professional configure this link for you. Setup and configuration of the SharePoint sites and user accounts are outside the scope of this document.

**Supported file types**—all image and text file formats, except HTML, are available when scanning to the SharePoint site. Note that text file formats are only available if an OCR module or application is installed. Please refer to Text Formats on page 28 to see a list of text file formats that are available when OCR is installed.

**Destination type**—the SharePoint destination is classified as a “Storage Link”. To make it available in the destination list, you must select Storage and CD-R/W on the Options tab in the OneTouch Properties window.

All configuration of the SharePoint server is done using the SharePoint settings tab in the Scan Configuration Properties window.
1. Select **SharePoint** as the destination application.

![Scan Configuration Image]

2. Open the Scan Configuration you want to modify for scanning to a SharePoint site, or create a new Scan Configuration.

   Select an existing configuration in which you have already specified your SharePoint site information, and then click on the **Copy** button to create a new configuration using the settings of the current configuration.

3. Click on the **SharePoint** tab and fill in the fields with the information for your SharePoint site.

   ![SharePoint Tab Image]

   - **Protocol**—select which protocol you want to use to transfer the scan to the server.
   - **SharePoint URL**—input the full URL path of the SharePoint site without the http(s):// designation and actual page. This path should include everything except the destination folder.

   For example, if the web browser URL displays `http://sharepoint.site.com/IT/common/shared documents/default.aspx`, then you would configure the SharePoint server path as follows:

     - Select **HTTP** as the protocol
     - The SharePoint URL would be `sharepoint.site.com/IT/common`
     - The Destination folder would be `shared documents`

   - **User account**—input the user account name that has privileges to save files to the specified SharePoint site and Destination folder.
● **Password**—input the password for the user account name you specified.

● **Use Windows Integrated Authentication**—select this option to use the Windows current user's login name and password to access the SharePoint site.

● **Destination folder**—this is the folder where the final scanned document(s) are transferred to when scanning is complete.

● **Filename format**—select a file naming format, for the scanned document, from the list. Select "Use custom file naming" to use the file you set on the Options tab in the OneTouch Properties window.

  **Count**—this field will enable when the selected Filename format contains {seq}. Input the number you want the sequential count to start from.

  **Filename prefix**—this field will enable when the selected Filename format contains {prefix}. Input the name or value you want as the prefix in the final file name.

Because the destination configuration is done through the scan configuration, you can set each configuration to scan to different SharePoint site, folder, filename format, using different user credentials, and so on. This is the same process used as when scanning to different folders using the Transfer to Storage destination, as described in detail starting on page 46.

Click on the **Help** button, in this configuration tab, to launch the SharePoint help file. The help file contains detailed information about the settings in this window and technical implementation notes.

### SharePoint Link Log Viewer

The OneTouch Link Log Viewer opens automatically when scanning is complete. Click on the menu arrow next to View logs for and select SharePoint Link from the list to display the transfer history for the SharePoint link only.

![SharePoint Link Log Viewer](image)

Double-click on any of the line items to open the selected log file in the Log File Detail View. If you open a failed transfer, the log file may contain the information you need to determine why the transfer failed. After you address the failure indicated in this log file, you can click the **Retry** button to resend the document to the server.
Click on the **Properties** button to open the Log Viewer from the SharePoint OneTouch Link Properties window. There are no global configuration properties for the SharePoint destination application, all configuration is done using the Scan Configuration Properties window as described in the previous section.

**FTP Transfer**

The **FTP Transfer** destination link allows scans to be sent directly to an FTP server from OneTouch. Please contact your server administrator for the server information you need to configure this link. Alternatively, have your site administrator or IT professional configure this link for you. Setup and configuration of the FTP server and user accounts are outside the scope of this document.

**Supported file types**—all image and text file formats, except HTML, are available when scanning to an FTP server. Note that text file formats are only available if an OCR module or application is installed. Please refer to **Text Formats** on page 28 to see a list of text file formats that are available when OCR is installed.

**Destination type**—the FTP Transfer destination is classified as a “Storage Link”. To make it available in the destination list, you must select Storage and CD-R/W on the Options tab in the OneTouch Properties window.

All configuration of the FTP server is done using the FTP Transfer tab in the Scan Configuration Properties window.
1. Select **FTP Transfer** as the destination application.

![FTP Transfer screenshot]

2. Open the Scan Configuration you want to modify for scanning to an FTP server, or create a new Scan Configuration.

Select an existing configuration in which you have already specified your FTP server information, and then click on the **Copy** button to create a new configuration using the settings of the current configuration.

3. Click on the **FTP Transfer** tab and fill in the fields with the information for your FTP server.

- **Protocol**—select which protocol you want to use to transfer the scan to the server.
- **Host**—input the internet or intranet path of the server where you want to send the scanned documents. You do not need ftp:// at the beginning. For example, ftp.company.com
- **Port**—input which port to use with the selected protocol. Changing the selected protocol will reset this value to the appropriate default for the protocol.
- **User account**—input the user account name that has privileges to save files to the specified host destination folder.
- **Password**—input the password for the user account name you specified.
- **Destination folder**—input the folder path, on the remote FTP server, where you want the scanned documents sent. This path would appear in your web browser after the host name. For example, marketing/shared documents/data sheets.
Because the destination configuration is done through the scan configuration, you can set each configuration to scan to a different FTP server, destination folder, and so on. This is the same process used as when scanning to different folders using the Transfer to Storage destination, as described in detail starting on page 46.

**FTP Link Log Viewer**

The OneTouch Link Log Viewer opens automatically when scanning is complete. Click on the menu arrow next to View logs for and select **FTP Link Agent** from the list to display the transfer history for the FTP link only.

Double-click on any of the line items to open the selected log file in the Log File Detail View. If you open a failed transfer, the log file may contain the information you need to determine why the transfer failed. After you address the failure indicated in this log file, you can click the **Retry** button to resend the document to the server.

Click on the **Properties** button to open the Log Viewer from the FTP OneTouch Link Properties window. There are no global configuration properties for the FTP destination application, all configuration is done using the Scan Configuration Properties window as described in the previous section.
The SMTP destination link allows scans to be sent directly to an email address, through an SMTP server, from OneTouch. Please contact your server administrator for the server information you need to configure this link. Alternatively, have your site administrator or IT professional configure this link for you. Configuration of the SMTP server settings and user accounts is outside the scope of this document.

**Supported file types**—all image and text file formats, except HTML, are available when scanning to an SMTP server. Note that text file formats are only available if an OCR module or application is installed. Please refer to Text Formats on page 28 to see a list of text file formats that are available when OCR is installed.

**Destination type**—the SMTP destination is classified as an “Email Link”. To make it available in the destination list, you must select Email on the Options tab in the OneTouch Properties window.

All configuration of the SMTP server is done using the SMTP Settings tab in the Scan Configuration Properties window.

1. Select SMTP as the destination application.

2. Open the Scan Configuration you want to modify for scanning to an SMTP server, or create a new Scan Configuration.

   Select an existing configuration in which you have already specified your SMTP server information, and then click on the Copy button to create a new configuration using the settings of the current configuration.
3. Click on the **SMTP Settings** tab and fill in the fields with the information for you SMTP server.

![SMTP Settings Window](image)

- **Protocol**—select which protocol you want to use to transfer the scan to the server.
- **Host**—input the internet or intranet path of the server where you want to send the scanned documents. For example, smtp.company.com
- **Port**—input which port to use with the selected protocol. Changing the selected protocol will reset this value to the appropriate default for the protocol.
- **User account**—input the user account name that has privileges to send email messages through the SMTP server.
- **Password**—input the password for the user account name you specified.
- **Use Windows Integrated Authentication**—select this option to use the Windows current user’s login name and password to send the message through the SMTP server.
- **Email to**—input a valid recipient email address to receive the scanned document. If it is not a valid address the transfer will fail.
- **Email from**—input the email address you want to appear in the email message “from” field.
- **Limit (MB)**—input the maximum message size limit set on the SMTP server. This number should be lower than or match the SMTP server maximum. You cannot send messages that exceed the maximum message size of the SMTP server.

Because the destination configuration is done through the scan configuration, you can set each configuration to scan to a different SMTP server, send messages to different email addresses, using different user credentials, and so on. This is the same process used as when scanning to different folders using the Transfer to Storage destination, as described in detail starting on page 46.

Click on the **Help** button, in this configuration tab, to launch the SMTP help file. The help file contains detailed information about the settings in this window and technical implementation notes.
SMTP Link Log Viewer

The OneTouch Link Log Viewer opens automatically when scanning is complete. Click on the menu arrow next to View logs for and select SMTP Link Agent from the list to display the transfer history for the SMTP link only.

Double-click on any of the line items to open the selected log file in the Log File Detail View. If you open a failed transfer, the log file may contain the information you need to determine why the transfer failed. After you address the failure indicated in this log file, you can click the Retry button to resend the document to the server.

Click on the Properties button to open the Log Viewer from the SMTP OneTouch Link Properties window. There are no global configuration properties for the SMTP destination application, all configuration is done using the Scan Configuration Properties window as described in the previous section.

Email Applications

Scanning to an email application, such as Outlook or Windows Mail, attaches the scanned image to a blank email message. You then fill in the recipient email address(es) and send the message. You need to have configured an email application before you can scan to it using OneTouch. If you do not have your email application set up prior to scanning, the default Windows email application will open and ask you to configure your user information. Please contact your IT department, server administrator, or other group that provided you the email information for setup instructions. Configuring an email application and user account is outside the scope of this document.
**Supported file types**—all image and text file formats, except HTML, are available when scanning to an email application. Note that text file formats are only available if an OCR module or application is installed. Please refer to Text Formats on page 28 to see a list of text file formats that are available when OCR is installed.

**Destination types**—the email destination is classified as an “Email Link”. To make it available in the destination list, you must select Email on the Options tab in the OneTouch Properties window.

![OneTouch Scan Interface](image)

The email application in the OneTouch destination list is the default email program selected in the Internet Options of Internet Explorer. Click on the email application that is in the list, then click on the **Properties** button to launch the Email OneTouch Link Properties window to change the email application.

### Email Properties

Use the Email Link Properties window to select a folder for storing a permanent copy of the scanned image, setting the color document options, and changing the email application that is in the OneTouch destination list.

![Email Link Properties](image)

- **Folder for storing attachments**—click the **Browse** button to change the location using the Windows file browser, or type a location directly in the field.
- **Internet options**—if you need to change your email client, or any other internet options, click the Internet Options button.

  The Windows Internet Options Control Panel opens. Click the Programs tab and choose a new email client from the program list. These are the standard Windows Internet Explorer options. Please see your Windows documentation for more information about the Internet Explorer options.

**Color document handling**—click in the Color document handling settings boxes for the options you want.

- **Convert Bitmaps using Screen Resolution**—use this option to ensure that an image will fit on the computer’s screen.

- **Convert Bitmaps to JPEG**—JPEG files can be compressed to produce smaller file sizes and, therefore, shorter transmission times when you email the file or upload it to the internet.

If you changed the email application Internet Explorer, and it does not immediately appear in the Select destination list, click the Refresh button to update the destination list in OneTouch.

**TEXT EDITORS**

Scanning to a text editing application, such as Microsoft’s Notepad or WordPad, automatically converts the text in the scanned image into editable text using Optical Character Recognition (OCR).

**Supported file types**—the text file formats and destination applications are only available if an OCR module or application is installed. Please refer to Text Formats on page 28 to see a list of text file formats that are available when OCR is installed. Additionally, the available file formats are application specific, for example Microsoft’s WordPad can open *.txt and *.rtf files, so only those two file types will be available when scanning to WordPad.

Note that when there is no OCR module or application installed, the format panel will not contain a text icon and there will be no text editor applications in the Select destination list.

**Destination type**—this destination type is classified as a “Text Based Link”. To make it available in the destination list, you must select Text editing applications on the Options tab in the OneTouch Properties window. If the text editing application you are using does not appear in the Select destination list, you can add the application using the Text Documents OneTouch Link Properties window.
1. In the OneTouch Properties window select one of the default text editors such as WordPad.

![OneTouch Properties Window](image)

2. Click on the **Properties** button to open the Text Document OneTouch Link Properties window. From this window you can select what OneTouch should do when text is not detected or recognition fails, and add other applications to OneTouch.

   Note that if you recently installed an application, click the **Refresh** button to see if OneTouch will automatically configure the link before you try adding it manually.

### Text Documents Properties

These properties apply to Microsoft Word, Microsoft Excel®, and any other text editing applications indicated by their icons in the list.

![Text Documents Properties](image)

- **Add application**—click this button to open the Add Text Based Link dialogue so you can add other text editing applications to OneTouch.

- **Delete application**—select an application in the list then click this button to remove the application from the OneTouch destination list. You can only delete an application that you have added, the destinations that are linked when OneTouch is installed cannot be deleted.
General OCR settings—click in the OCR settings boxes for the options you want. The options will apply to all the applications in the group.

- **Always send a file, even when no text was found**—the scanned file is sent to the application even if the image does not appear to contain text. This could occur if you scanned a photograph with a scanner button set for text applications.

- **Show message if text recognition failed**—a message will open on the screen if the OCR reader does not detect text in the image.

Adding Text Editor Applications

1. To add another application to the list, click the **Add application** button. The Add Text Based Link dialog box opens.

2. Click **Browse** to find the application you want to add to the list.

   When you select the application using the Browse button, Steps 1 and 2 on the dialog box are automatically filled in, and the application icon appears in Step 3.

3. Select the icon in Step 3 of the dialog box. That is the icon that will appear in the OneTouch Destination List.

4. In Step 4 of the dialog box, select the file formats that the application will accept.

   - **HTML Formatted file**—select this option when you want to scan to your web browser for posting HTML pages to a website. Even though word processing applications, such as Notepad and Word can open *.htm files, you cannot scan as *.htm to word processing text editors. Scanning as HTML creates a directory with the *.htm file and linked images for website use. Word processing applications cannot accept a directory structure for image and text transfer.

   - **Rich Text Format**—select this option if your application can open *.rtf files, which are plain text documents that contain formatting. Microsoft’s WordPad application is a compatible application for the *.rtf file formation.

   - **Standard ASCII text file**—select this option if you want to have plain text, without formatting, sent to your text editing application. Most text editing applications will accept plain text (*.txt) files.
● **Adobe PDF format**—select this option if you are adding a PDF viewing or editing application to the list. This PDF format is an image format only, it will not recognize the document using OCR, and you will not be able to search or edit the text in the final file. The application you are adding must be able to open *.pdf files.

● **Adobe searchable PDF**—this is the PDF image format with a hidden searchable text layer. You will not be able to edit the text the file. The application you are adding must be able to open *.pdf files.

The options you select at Step 4 determine the page format icons in the OneTouch Properties window for that group of applications. Refer to the documentation you received with the application to see which text formats the application accepts.

5. When you are done making changes in this window, click the Add button to accept the changes and close the window.

6. Click OK on the Link Properties window.

7. Click Refresh on the OneTouch Properties window and the new application should now be available.

### Creating an HTML Page

1. Open the OneTouch Properties window.

2. Select your web browser as the Destination Application and choose HTML as the Format.

3. Choose a Scan Configuration that has the settings for how you want any images, on the pages you are scanning, to be displayed. For example, choose a color or grayscale scan configuration if your documents contain images that you want posted to your website with the HTML text.

4. Click OK.

5. Start scanning using the button you selected for scanning with the HTML format.

When scanning is finished, the document is first converted to editable text using the OCR process, then converted into an HTML format. Any images detected by the OCR engine are isolated and linked as *.gif files.

6. Microsoft Internet Explorer, or other web browser you scanned to, then opens showing your converted page. The application's URL field shows the location where OneTouch saved the HTML files for you to locate and post to your website.
**STILL IMAGE CLIENT**

If you want to specify an application to use for scanning at the start of the process, you can use event forwarding.

**Supported file formats**—you cannot select a file format when scanning to the Still Image Client as the destination application is not selected until after you start scanning.

**Destination type**—the Still Image Client destination is classified as an “Event Forward Link”. To make it available in the destination list, you must select STI event forwarding on the Options tab in the OneTouch Properties Window.

Please note that if you have turned on the option to scan to multiple destinations, the Still Image Client destination cannot be selected. Please click on the Options tab and deselect Enable scanning to multiple destinations to proceed with scanning to this destination.

1. Open the OneTouch Properties window, and select **Still Image Client** as the Destination Application.
2. Click **OK**.
3. Start scanning using the button you selected for event forwarding.
4. A dialog box opens for you to select the application to use for scanning. Select the application you want in the box and click **OK**.

Now the application you selected opens and you can continue scanning using that application’s interface.
Technical Note

If the scanner scans and sends an image to an application without prompting you to choose an application to run, the control panel options for your scanner’s events are automatically set to run a specific program when an event is initiated. Follow these steps to change the events setting for your scanner.

1. Open the Windows Control Panel.
2. Open the Scanners and Cameras group.
   - When the Control Panel is in Classic View, the Scanners and Cameras group will be in the list.
   - When the Control Panel is in Category View (Windows XP), or Home View (Windows Vista, 7 and 8), the Scanners and Cameras group will be located under either of the following main groups:
     - Windows XP—Printers and Other Hardware
     - Windows Vista, 7 and 8—Hardware and Sound
3. Open the scanner properties window.
   - Windows XP—click on the scanner icon and then click on the View device properties link on the left side of the window.
   - Windows Vista, 7 and 8—click on the scanner icon and then click on the Properties button.
4. Click on the Events tab.
5. Select the option Prompt for which program to run to be prompted when scanning to Still Image Client. Alternatively, select Start this program then choose an application from the list to have that application start each time you scan to Still Image Client.
6. Click on OK when you are done making changes to this window.
7. Now when you scan with Event Forwarding you will either be prompted to choose an application, or the default application you selected will open.

Image Editors

Image editors include Microsoft Paint and other drawing and graphics applications.

Supported file formats—the available file formats are based on the selected destination application. For example, you can scan to Microsoft’s Paint application as a BMP, GIF, PNG, or JPG, but not as TIFF. Please refer to Image Formats on page 26 for more information on which image formats OneTouch supports.

Destination type—this destination type is classified as a “Simple Image Link”. To make it available in the destination list, you must select Image editors (i.e. Paint) on the Options tab in the OneTouch Properties window. If the image editing application you are using does not appear in the Select destination list, you can add the application using the Image Documents OneTouch Link Properties window.
1. In the OneTouch Properties window select one of the default image editors such as Microsoft Paint.

![OneTouch Properties window]

2. Click on the Properties button to open the Image Documents OneTouch Link Properties window. From this window you can add an application and set additional document handling options. Note that if you recently installed an application, click the Refresh button to see if OneTouch will automatically configure the link before you try adding it manually.

**Image Documents Properties**

These properties apply to Microsoft Paint and other image processing applications.

- **Add application**—click this button to open the Add Simple Image Link dialogue so you can add other image editing applications to OneTouch.

- **Delete application**—select an application in the list then click this button to remove the application from the OneTouch destination list. You can only delete an application that you have added, the destinations that are linked when OneTouch is installed cannot be deleted.
**Color document handling**—click in the Color document handling settings boxes for the options you want. These options will apply to all the applications in the group.

- **Convert Bitmaps using Screen Resolution**—use this option to ensure that an image will fit on the computer’s screen. When a computer screen is set to a lower resolution, bitmap images with a higher resolution may be too big to fit on the screen. Converting the bitmap image to match the screen resolution ensures that the image fits on the screen.

- **Convert Bitmaps to JPEG**—JPEG files can be compressed to produce smaller file sizes and, therefore, shorter transmission times. Use this option to provide that compression capability to image files.

**Adding Image Editor Applications**

1. To add another application to the list, click the **Add application** button.

2. Click **Browse** to find the application you want to add to the list.

   When you select the application using the Browse button, Steps 1 and 2 on the dialog box are automatically filled in, and the application icon appears in Step 3.

3. Select the icon in Step 3 of the dialog box. That is the icon that will appear in the OneTouch Destination List.

4. In Step 4 of the dialog box, select the file formats that the application will accept.
   - **Windows Bitmap File**—select this option if you want to scan to your image application as a BMP file. This format creates the largest file size as the final scanned image has not been compressed.
   - **Tagged Information File**—select this option if your application supports TIF image files. The TIF file format supports multiple pages in a single file.
   - **JPEG Compressed File**—this is a compressed image format that is often used when sharing photographs and scanned images electronically as the file size is smaller than a BMP.
- **Compugraphics File**—select this option if your application supports GIF images. This file format is often used for icons and small images on a web page.

  The options you select at Step 4 determine the page format icons in the OneTouch Properties window for that group of applications. Refer to the documentation you received with the application to see which text formats the application accepts.

5. When you are done making changes in this window, click the **Add** button to accept the changes and close the window.

6. Click **OK** on the Link Properties window.

7. Click **Refresh** on the OneTouch Properties window and the new application should now be available.

## PDF Applications

PDF destinations are applications that can open and/or edit the Adobe PDF file format.

**Supported file types**—applications in the PDF destination group support the *.pdf file format. When the OmniPage module or software is installed, OneTouch includes an option to scan as sPDF or nPDF. Selecting either of these two formats still creates a *.pdf file, but the “s” and “n” letters indicate that OCR will process the image before sending the file to the PDF application.

- **sPDF**—this format creates a *.pdf file that contains the original image of the scanned page, with a hidden text layer that allows you to search for text in the file.

- **nPDF**—this format creates a *.pdf file that can be edited in a PDF application. Any pictures in the scanned image are isolated from the text, the text on the page is recognized and turned into editable text, and the pictures are placed back into the document in the same flow as the original document.

**Destination type**—this destination type is classified as “PDF Link”. To make it available in the destination list, you must select PDF applications on the Options tab in the OneTouch Properties window.

If the PDF application you are using does not appear in the Select destination list, you can add the application using the Text Documents OneTouch Link Properties window.

1. Click on the **Options** tab in the OneTouch Properties window.
2. Make sure PDF applications and Text editing applications are selected then click back on the button tab.

Please note that any PDF application you add manually to OneTouch will be classified as a “Text Based Link.” These applications will only show in the destination list when Text editing applications are enabled.

3. Click on one of the default text editors such as WordPad.

4. Click on the **Properties** button.

5. To add another application to the list, click the **Add application** button. The Add Text Based Link dialog box opens.

6. Click **Browse** to find the application you want to add to the list.

When you select the application using the Browse button, Steps 1 and 2 on the dialog box are automatically filled in, and the application icon appears in Step 3.

7. Select the icon in Step 3 of the dialog box. That is the icon that will appear in the OneTouch Destination List.
8. In Step 4 of the dialog box, select Adobe PDF format and Adobe searchable PDF.

**Adobe PDF format**—select this option if you are adding a PDF viewing or editing application to the list. This PDF format is an image format only, it will not recognize the document using OCR, and you will not be able to search or edit the text in the final file. The application you are adding must be able to open *.pdf files.

**Adobe searchable PDF**—this is the PDF image format with a hidden searchable text layer. You will not be able to edit the text the file. The application you are adding must be able to open *.pdf files.

The options you select at Step 4 determine the page format icons in the OneTouch Properties window for that group of applications. Refer to the documentation you received with the application to see which text formats the application accepts.

9. When you are done making changes in this window, click the **Add** button to accept the changes and close the window.

10. Click **OK** on the Link Properties window.

11. Click **Refresh** on the OneTouch Properties window and the new application should now be available.

## Send to Application

The **Send to Application** link allows you to select any application on your computer as the scan destination.

**Supported file types**—all file formats in OneTouch are available when scanning to this destination. After you configure the link, as described below, make sure you select a file format that the application can open. Please refer to Text Formats on page 28 to see a list of text file formats that are available when OCR is installed.

**Destination type**—this destination type is classified as “Document Management Link”. To make it available in the destination list, you must select **Document Management** on the **Options** tab in the OneTouch Properties window.

You must configure this destination before attempting to scan to it the first time. If you scan without configuring the link first, the OneTouch log viewer will open and show that sending the image to the **Send to Application** link failed.
■ Click the **Properties** button to open the OneTouch Link Properties for the **Send to Application** link. From this window, you can configure the default application for this link.

After configuring the link properties, all of the default scan configurations will immediately update to send to the application you specify in this window. When you create new configurations, the default settings will also match what you have selected here. If you modify the options in an individual configuration, changing the options in this Link Properties window will no longer update to the configurations you modified.

■ Click the **New**, **Copy**, or **Edit** button to open the Scan Configuration Properties window. Click on the **Send to Application** tab and use this window to set a configuration to scan to a different application than the one selected in the Link Properties window.

Changing the options in this window only affects the configuration you are creating or modifying. All other configurations will retain their settings for this destination.

**To configure a destination application for the Send to Application link:**

1. Click **Browse** to open the Windows file browser and navigate to the location of the application’s executable (*.exe) file.

   In most cases, the application’s directory is located in the programs directory on the C:\ drive. Because you can select any executable file, make sure you select an application that can receive image or text files.

2. Select the application’s *.exe file then click on **Open**.

   The application’s *.exe file path will now show in the Application path field.

3. Click on **OK** to close the window.

   For basic scanning, you do not need to adjust any of the other settings in this window. The default settings will work with most applications. The advanced settings are described below.

4. Select a file format and scan configuration in the OneTouch Properties window.

   If you select a text file format, the scanned image is converted into editable text before being sent to your selected application.

5. Click on **OK** to close OneTouch.
6. Put the document(s) in the scanner and start scanning with the button you set to use the Send to Application destination.

7. The scanner starts scanning and, when finished, sends the scanned file to the application you selected.

Technical note

- After configuring this link, you may need to click **Refresh** in the OneTouch Properties window to show the correct application icon in the **Select destination** list.

**Configure advanced features**—select this option to change the default settings for this link. Only advanced users and application developers should modify these settings.

- **Launch application for every image**—when this option is selected, the application will open one time for each image scanned. You should deselect this option only if the application you are scanning to will accept multiple page files.

For example, Microsoft’s Paint application can only accept 1 image at a time, so when scanning multiple images, Paint would open each time an image is transferred when this option is selected. On the other hand, Microsoft’s WordPad will open a multiple page file, so when scanning multiple images WordPad would need to launch only one time when this option is not selected. If you scan to WordPad and this option is still selected, then WordPad will open 1 time for each image transferred.
■ **Generate Metadata**—this option should be used when barcode detection has been enabled in the TWAIN UI. When this option is selected and a page containing a barcode is scanned, a separate file will be created containing the barcode metadata. This file will be saved in the same location as the image and should be deleted after the contents has been read.

The metadata file will have the same name as the scanned image with an added .MD file extension. For example: ~OTTDE51001F.JPG.MD.

contain the following information for each page:

[Page 1]
BarcodeCount=2
BarcodeType1=0
BarcodeText1="SCN - TAX"
BarcodeType2=12
BarcodeText2="NAME=2014 John & Elizabeth Smith"

Where the barcode type is a number corresponding to a barcode in the following table.

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Code 39 (3 of 9)</td>
</tr>
<tr>
<td>1</td>
<td>Interleaved 2 of 5</td>
</tr>
<tr>
<td>2</td>
<td>Non interleaved 2 of 5</td>
</tr>
<tr>
<td>3</td>
<td>Code 93</td>
</tr>
<tr>
<td>4</td>
<td>Code 128</td>
</tr>
<tr>
<td>5</td>
<td>GS1-128</td>
</tr>
<tr>
<td>6</td>
<td>Codabar</td>
</tr>
<tr>
<td>7</td>
<td>UPC-A</td>
</tr>
<tr>
<td>8</td>
<td>UPC-E</td>
</tr>
<tr>
<td>9</td>
<td>EAN-8</td>
</tr>
<tr>
<td>10</td>
<td>EAN-13</td>
</tr>
<tr>
<td>11</td>
<td>POSTNET</td>
</tr>
<tr>
<td>12</td>
<td>PDF-417</td>
</tr>
<tr>
<td>13</td>
<td>2 of 5 Industrial</td>
</tr>
<tr>
<td>14</td>
<td>2 of 5 Matrix</td>
</tr>
<tr>
<td>15</td>
<td>2 of 5 Datalogic</td>
</tr>
<tr>
<td>16</td>
<td>2 of 5 IATA</td>
</tr>
<tr>
<td>17</td>
<td>3 of 9 Full ASCII</td>
</tr>
<tr>
<td>18</td>
<td>Codabar with start stop</td>
</tr>
<tr>
<td>49</td>
<td>Maxicode</td>
</tr>
<tr>
<td>20</td>
<td>QR Code</td>
</tr>
<tr>
<td>32769</td>
<td>GS1 Databar (RSS 14)</td>
</tr>
<tr>
<td>32770</td>
<td>GS1 Databar (RSS Expanded)</td>
</tr>
<tr>
<td>32771</td>
<td>Aztec</td>
</tr>
<tr>
<td>32772</td>
<td>DataMatrix</td>
</tr>
<tr>
<td>All others</td>
<td>Unrecognised</td>
</tr>
</tbody>
</table>

■ **Append job status to arguments**—when this option is selected, a command line argument will be added showing the job status.

The argument will have the format [/JobStatus] [ID] [/JobStatus]

Where the job status can be _JobStart for the first image, _JobContinue for the second page onwards. and _JobEnd for the last page. For example:

/JobStatus 008ED7DC_C668_4107_9153_996CC0262A1C_JobStart
- **Command line arguments**—input the options that are to be used when the application is launched. These values are application specific and you should only input values that were provided to you by the application developer. Command line arguments are not required for you to use this link, the field can be left blank and you can change the other settings in this section as needed.

- **Append scan filename(s) to arguments**—this option adds the name of every image file to the end of the list of arguments specified above. This is the default selection as most applications do not require, and may not work with, a job file containing the image names.

- **Append job file to arguments**—this option adds the name of a job file to the end of the list of arguments specified above. This unique file is created at scan time and contains a list of every image in the scan job. Only select this option if you are sure that the application you are scanning to can use the job file to accept image transfer.

### Scanning to Multiple Destinations

Scanning to multiple destinations works the same as when scanning to a single destination, OneTouch simply distributes the final scan to several destinations. This option is enabled separately for each OneTouch button.

1. Open the OneTouch Properties window and click on the **Options** tab.

2. Select **Enable scanning to multiple destinations**, then click back on the configuration tab.
3. Click each destination where you want to send the scanned image in the **Selected destinations (#)** list. Click again to deselect a destination.

As you click on each destination, the Selected destinations number will count so you know how many applications are selected to receive the image.

4. If any of the destinations you select have global configuration properties, the Properties button at the bottom of the Selected destinations list will be enabled for you to configure the destination options. Click on the **Properties** button to open the OneTouch Link Properties window to configure the destinations.

Each destination that has global properties will be represented by its configuration tab in the OneTouch Link Properties window. Please refer to the destination instructions, as described in the previous section(s), for configuring destination specific options.

Click on **OK** when you are done making changes in this window.
5. Select the file format you want for the scanned image in the **Select format** panel.

You can only scan as one file format at a time, so all selected destinations must have a common file type. As you select destinations, destinations that do not have a file type in common with the one you selected, will automatically disable.

For example, if you scan to a printer and to email, only the BMP file format will be available as printers can only receive an uncompressed image format. All other image formats and all text formats will be disabled until you deselect the printer.

6. Select the scan configuration you want to use for scanning in the **Select configuration** list.

Click on the **Edit** button to open the Scan Configuration Properties window to configure any destination specific scanning options.

Each destination that has per-scan configuration properties will be represented by its configuration tab in the OneTouch Scan Configuration Properties window. Please refer to the destination instructions, as described in the previous section(s), for configuring destination specific options.

Click on **OK** when you are done making changes in this window.

7. Click on **OK** on the OneTouch Properties window.

8. Load the document(s) in the scanner and start scanning with the button you set to scan to multiple destinations.

The scanner starts scanning and when finished, the image is sent to each destination you selected in the OneTouch Properties window.

**Technical Note**

- The **Still Image Client** destination cannot be used with multiple destination scanning. This destination will be disabled when the **Enable scanning to multiple destinations** is selected.
The OneTouch Hardware Properties window shows information about your scanner. From this window you can launch the scanner’s Device Configuration Properties window.

1. Right-click on the OneTouch icon and choose **Show Hardware** from the pop-up menu.

2. The Hardware Properties dialog box opens and shows information about your scanner.

3. Click the **Properties** button to open the Device Configuration Properties window.
**Device Settings**

The Device Settings panel shows the hardware information for your scanner. If your scanner has any hardware adjustment options or automatic cleaning options, they will show here. These options are specific to the current scanner and described in the “Maintenance” section of the scanner guide. The scanner guide is located in the user guide section of the installation disc.

Depending on your operating system and user credentials, these options may be disabled. Due to this, your scanner user guide will contain the instructions on accessing this window through the Windows Control Panel.
**Driver Settings**

The options in this panel are for configuring how the TWAIN interface will behave in some scenarios. Please see the TWAIN scanning guide on the installation disc for instructions. You can also click the Help button in the TWAIN interface to open the instructions in an Internet browser.

![Driver Settings Panel](image)

**Application Settings**

This panel will show if your scanner has hardware options that affects the way one of the scanning interfaces behaves. Please disregard this section if you do not see an Application Settings panel.

![Application Settings Panel](image)
■ **Turn on AutoLaunch™**—this option will be in the interface if your scanner has a front feed. When it is enabled, scanning will start automatically when an item is inserted into the front of the scanner. The instructions for using this option are located in the “Loading Documents” chapter of the scanner user guide.

■ **Combine with**—this option will be in the interface if your scanner has a USB port to connect it to another scanner. The instructions for using this option are located in the “Connect to Another Scanner” chapter of the TWAIN scanning guide.
Troubleshooting

**Problem:** The scanner buttons stop working after scanning with Windows Image Acquisition (WIA).

After performing a scan using the WIA interface you must close the application you were using before scanning with the buttons on the scanner. This does not occur when scanning using the TWAIN interface.

**Problem:** The installation will not complete successfully. If installation finishes, the scanner’s OneTouch options do not seem to work properly.

A likely cause is that some driver programs are already installed on your computer for another scanner. Or you previously had another Visioneer or Xerox® scanner and that driver program is still on your computer. They are interfering with the installation and OneTouch options, and you need to remove those other drivers and re-install your scanner. Please see the documentation that you received with the other scanner for the steps to remove its driver programs.

**Problem:** The computer keeps displaying out of hard drive space error messages.

The minimum system requirement of free hard drive space is for the installation of the software and basic, low resolution, scanning. High resolution scans result in files that can be over 1 gigabyte in size. Free up some space on your hard drive for the software to be able to save the scanned images.

**Problem:** The computer keeps displaying out of memory error messages.

An “Out of memory” message may appear when scanning long pages at higher resolutions. This error is most often seen on Windows XP due to the large file size created when scanning long pages in color or grayscale at 300 dpi or higher. However, this error may occur on other operating systems as well. If you see an out of memory error message, please try adjusting the page length and/or scan resolution.

**Problem:** When using “Create single image files” not all of the pages scanned are sent to the selected destination.

There are a limited number of times that an application can open. When “Create single image files” is selected and you are scanning to a destination application, each side of the page scanned will open a new instance of that application. If you want to have an image open in an application immediately, limit your scan batch to less than 5 pages.

Alternatively, you can set your destination to be a folder location on your computer or network using “Transfer to Storage”. Select any file format and then scan a large batch of papers. At the end of scanning, the driver will immediately save all pages scanned to that folder location without opening an application.
**Problem:** When using “Skip Blank Originals” not all of the blank pages have been removed.

If you are scanning light weight paper, such as 16lb or 18lb printer paper, the scanner may be picking up faint images through the paper and the driver will not drop those pages out of the final file. The “Skip Blank Originals” result will vary based on the DPI range and paper weight. Generally 100 dpi or 150 dpi produces the best results.

**Problem:** Repairing OneTouch using the 'Change' function in the Windows Control Panel programs list did not repair it.
1. Before attempting to repair OneTouch, unplug the USB cable connected to the scanner.
2. Perform the Change/Repair function again. If you are asked for the Install DVD, insert the disc into the DVD-ROM player and click OK.
3. When prompted, plug the USB cable back into the scanner.
4. When the installation process finishes, click OK on the Complete The Installation window, and then click Close.
5. Reboot your computer.

**Problem:** OneTouch no longer functions after updating Internet Explorer on Windows XP.

This is a known issue where OneTouch stops responding when Internet Explorer is installed after the scanner. To resolve the issue:
1. Open the Windows Add/Remove Programs feature from the Control Panel.
2. Find Windows Internet Explorer and uninstall it using the change/remove options. Follow the wizard through a complete removal of the Internet Explorer software.
3. Find OneTouch and uninstall it using the change/remove options. Follow the wizard through a complete removal of the OneTouch program.
4. Unplug your scanner’s USB cable from the computer.
5. Reboot your computer.
6. Install Internet Explorer.
7. Install your scanner driver.

**Problem:** An error message appears that OCR fails when scanning from OneTouch.

Anti-SpyWare software that is set to always run may interfere with the driver functionality. It is recommended that you temporarily disable or suspend the automatic protection feature during scanning. After scanning is complete and your file has been saved, turn the auto-protect feature back on. You do not need to close the Anti-SpyWare software.
Appendix A: Copy Regulations

United States

Congress, by statute, has forbidden the reproduction of the following subjects under certain circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions.

1. Obligations or Securities of the United States Government, such as:

<table>
<thead>
<tr>
<th>Certificates of Indebtedness</th>
<th>National Bank Currency</th>
<th>Coupons from Bonds</th>
</tr>
</thead>
<tbody>
<tr>
<td>Federal Reserve Bank Notes</td>
<td>Silver Certificates</td>
<td>Gold Certificates</td>
</tr>
<tr>
<td>United States Bonds</td>
<td>Treasury Notes</td>
<td>Federal Reserve Notes</td>
</tr>
<tr>
<td>Fractional Notes</td>
<td>Certificates of Deposit</td>
<td>Paper Money</td>
</tr>
</tbody>
</table>

Bonds and Obligations of certain agencies of the government, such as FHA, etc.

Bonds. (U.S. Savings Bonds may be photographed only for publicity purposes in connection with the campaign for the sale of such bonds.)

Internal Revenue Stamps. (If it is necessary to reproduce a legal document on which there is a canceled revenue stamp, this may be done provided the reproduction of the document is performed for lawful purposes.)

Postage Stamps, canceled or uncanceled. (For philatelic purposes, Postage Stamps may be photographed, provided the reproduction is in black and white and is less than 75% or more than 150% of the linear dimensions of the original.)

Postal Money Orders.

Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

Stamps and other representatives of value, of whatever denomination, which have been or may be issued under any Act of Congress.


3. Obligations or Securities of any Foreign Government, Bank, or Corporation.

4. Copyrighted material, unless permission of the copyright owner has been obtained or the reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law. Further information of these provisions may be obtained from the Copyright Office, Library of Congress, Washington, D.C. 20559. Ask for Circular R21.

5. Certificates of Citizenship or Naturalization. (Foreign Naturalization Certificates may be photographed.)
6. Passports. (Foreign Passports may be photographed.)
7. Immigration Papers.
8. Draft Registration Cards.
9. Selective Service Induction Papers that bear any of the following Registrant’s information:

<table>
<thead>
<tr>
<th>Earnings or Income</th>
<th>Dependency Status</th>
<th>Court Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous military service</td>
<td>Physical or mental condition</td>
<td></td>
</tr>
</tbody>
</table>

Exception: U. S. Army and Navy discharge certificates may be photographed.

10. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the various Federal Departments, such as FBI, Treasury, etc. (unless photograph is ordered by the head of such department or bureau.)

11. Reproducing the following is also prohibited in certain states: Automobile Licenses — Drivers’ Licenses — Automobile Certificates of Title.

The above list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case of doubt, consult your attorney.

**Canada**

Parliament, by statute, has forbidden the reproduction of the following subjects under certain circumstances. Penalties of fines or imprisonment may be imposed on those guilty of making such copies.

1. Current bank notes or current paper money.
2. Obligations or securities of a government or bank.
3. Exchequer bill paper or revenue paper.
4. The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a court of law.
5. Proclamations, orders, regulations or appointments, or notices thereof (with intent to falsely cause same to purport to have been printed by the Queen’s Printer for Canada, or the equivalent printer for a province).
6. Marks, brands, seals, wrappers or designs used by or on behalf of the Government of Canada or of a province, the government of a state other than Canada or a department, board, Commission or agency established by the Government of Canada or of a province or of a government of a state other than Canada.
7. Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a province or by the government of a state other than Canada.
8. Documents, registers or records kept by public officials charged with the duty of making or issuing certified copies thereof, where the reproduction falsely purports to be a certified copy thereof.
9. Copyrighted material or trademarks of any manner or kind without the consent of the copyright or trademark owner.

The above list is provided for your convenience and assistance, but it is not all inclusive, and no liability is assumed for its completeness or accuracy. In case of doubt, consult your solicitor.
OTHER COUNTRIES

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be imposed on those found guilty of making such reproductions.

- Currency notes
- Bank notes and cheques
- Bank and government bonds and securities
- Passports and identification cards
- Copyright material or trademarks without the consent of the owner
- Postage stamps and other negotiable instruments

Note: this list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact your legal counsel.
INDEX

A
Actual size, 52
Acuity Settings, 18
Acuity Settings Tab, 18
Add Application, 67, 72, 74
Add application, 66, 71
Advanced Clarity, 21
Advanced device settings, 52
Advanced Settings tab, 22
Apply button, 6
Aspect ratio, 52
Auto Color Detect, 21
Auto detect color, 18
AutoBrightness, 20
AutoCrop, 20
AutoCrop to Original, 16
AutoCrop to original, 18
AutoDeskew, 20
AutoOrientation, 21
AutoRotate image, 52

B
Background Smoothing, 21
Bayer, 19
Bit depth reduction, 19
Black&White mode, 14
Blank Page Deletion, 21
BMP file format, 26, 31
Brightness, 14
Burn to CD, 50
   — Destination application, 50
Button Tabs, 5

C
CD burner, 50
Center image, 52
Collate copies, 52
Color dropout, 17, 19
Color mode, 14, 30
Comma Delimited, 29
Configure Before Scan, 12, 31
   — Cancel, 32
Contrast, 14
Copy button, 6
Create single image files, 26, 33

CSV file format, 29

D
Delete button, 6
Despeckle, 19, 21
Destination application, 1, 6, 44, 53
   — Burn to CD, 50
   — Email application properties, 64
   — Event Forward (STI), 69
   — Image application properties, 71
   — Microsoft Explorer (HTML), 68
   — OCR, 5
   — Text application properties, 66
   — Text file format, 28
   — Transfer to Storage properties, 51
Device Settings tab, 52
DOC file format, 29
Document Management, 6
Dots per inch (dpi), 14, 30
Double Feed Detection, 17
Duplex, 15
Dynamic threshold, 19

E
Edge Cleanup, 20
Edge cleanup, 16
Edit button, 6
Email, 7
Email Link Properties, 64
Enable redaction, 23
Error diffusion, 19
Event Forward (STI), 7, 69
Excel Spreadsheet, 29

F
Fax and Print, 7
File format, 1, 26, 30
Fit to page, 52
Flip back side, 19
Flowing page, 41
Format tab, 40
FTP Link Agent, 60
FTP Transfer, 58
FTP Transfer tab, 59
G
Gamma, 22
Grayscale mode, 14, 17

H
Halftone, 19
Hardware properties, 3
HTM file format, 29, 68
HTML Document, 29
HTML page, 68
Hue, 22

I
Image Documents Properties, 71
Image Editors, 6
Image file formats, 26
Improvements and Settings, 15
Instant Delivery, 7
Instant delivery, 34
Internet Options, 65
Invert Image, 16

J
Job Separation, 32
JPG
   Image quality and file size, 27, 28
   JPG file format, 26, 31

K
Key icon, 12, 14

L
Languages in Document, 36
LED Number, 5
Lock icon, 12, 14
Log Viewer, 60

M
Maintain aspect ratio, 52
Manual Feed Mode, 17
Maximize Quality, 27, 28
Microsoft Internet Explorer, 68
Microsoft Outlook, 7
Microsoft Paint, 6, 71
Microsoft Word, 5, 7, 66
Minimize Size, 27, 28
Missing Character, 37
Moiré Patterns, 16
Multiple destinations,, 79

N
New button, 6
Normal, 27, 28
Normal PDF, 30
nPDF, 30, 73

O
OCR
   Columns, 41
   Tables, 41
OCR input format, 41
OCR Options, 35, 38
OCR output format, 41
OCR tab, 36
One Touch
   Scan multiple pages, 31
OneTouch
   Icon, 2, 4
   New settings, 4
   Options tab, 6
   Panel features, 3
   Properties, 5, 30, 44, 50, 53, 69
OneTouch Properties window
   Options, 12
Open Scanned Document(s), 43
Optical Character Recognition (OCR), 7, 28, 65
Options tab, 6

P
Page Settings tab, 15
Paper size, 15
PaperPort, 53
PaperPort tab, 54
PDF
   Image quality and file size, 27, 28
   PDF (nPDF) file format, 30
   PDF (sPDF) file format, 29
   PDF applications, 7, 73
   PDF file format, 7, 26, 31
   Perform edge cleanup, 19
   Professional Dictionaries, 37
   Properties button, 5

R
Recognition Quality, 37
Redaction Settings tab, 22
Reduce Moiré Patterns, 16
Refresh button, 6
Reject Character, 37
Resolution, 14, 30
Rich Text Format, 29
Rotate image, 18
RTF file format, 5, 29

S
Saturation, 22
Scan configuration, 1, 47
  Lock or unlock, 14
  New, 12
Scan multiple pages, 31
Scan Settings Tab, 13
Scan to Folder, 44
  Multiple folders, 46
Scanning mode, 12, 13, 30
Screen Resolution, 65, 72
Searchable PDF, 29
Select Button, 6
Select configuration, 5
  Properties, 13
Select destination, 6
Select format, 5
Select format panel, 26
Send to Application, 75
Set as scan destination, 46
SharePoint, 55
SharePoint tab, 56
Show all destinations, 6
Show Progress Window, 7
Simple Text, 29
Size, 15
Skip Blank Originals, 17
Skip blank originals, 18, 34
SMTP, 61
SMTP Link Agent, 63
SMTP Settings tab, 62
sPDF, 29, 73
Spreadsheet, 41
Sti event forwarding, 7
Still Image Client, 69, 81
Storage and CD-R/W, 7, 44
Storage location, 45
Storage Options tab, 45, 47
Straighten Image, 16
Straighten image, 18

T
Text Documents, 65
Text Documents Properties, 66
Text Editors, 7
Text file formats, 28
TIFF file format, 26, 31
Transfer to Storage, 44, 46
  File formats, 29
True page, 41
TWAIN, 15

TWAIN interface, 31, 32
TXT file format, 5, 29

U
Use job separator, 33
Use languages and dictionaries, 36
Use MRC, 30
Use TWAIN Driver PLUS settings, 14
User Dictionary, 37
  New, 37

V
Visioneer Acuity, 18

W
Watermark, 17
Word Document, 29

X
XLS file format, 29